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Power Analysis and Optimization Tutorial

This tutorial introduces the power analysis and optimization use model recommended for use with the
Xilinx® Vivado® Integrated Design Environment (IDE). The tutorial describes the basic steps involved in
taking a small example design from RTL to implementation, estimating power through the different
stages, and using simulation data to enhance the accuracy of the power analysis. It also describes the
steps involved in using the power optimization tools in the design.

VIDEO: The Vivado Design Suite QuickTake Video: Power Estimation and Analysis Using Vivado
shows how the Vivado Design Suite can help you to estimate power consumption in your design
and reviews best practices for getting the most accurate estimation.

e
o

VIDEO: The Vivado Design Suite QuickTake Video: Power Optimization Using Vivado describes the

E factors that affect power consumption in an FPGA, shows how the Vivado Design Suite helps to
minimize power consumption in your design, and looks at some advanced control and best
practices for getting the most out of Vivado power optimization.

Software Requirements

This tutorial requires that the Vivado Design Suite software 2017.1 release or later is installed. For
installation instructions and information, see the Vivado Design Suite User Guide: Release Notes,
Installation, and Licensing (UG973).

For hardware power measurement of 7 series devices, the tutorial requires Texas Instruments Fusion
Design Power Designer software, which can be downloaded from the following location:
http://www.ti.com/tool/fusion_digital_power_designer

For hardware power measurement of UltraScale™ devices, the tutorial requires Maxim Digital Power
Tool software, which can be downloaded from the following location:
https://www.maximintegrated.com/en/design/tools/applications/evkit-software/index.mvp?id=1183
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Hardware Requirements

Supported Operating Systems to run the Vivado Design Suite, and memory recommendations when
using the Vivado tools, are described in the Vivado Design Suite User Guide: Release Notes, Installation,
and Licensing (UG973).

Hardware Requirements for 7 Series Devices
e The hardware power measurements for 7 series devices

(needed in Lab 3: Measuring Hardware Power Using the KC705 Evaluation Board), require a
Xilinx Kintex®-7 FPGA KC705 Evaluation Kit. You can find information on the Evaluation Kit at this
location:

Xilinx Kintex®-7 FPGA KC705 Evaluation Kit
e For power measurements through Tl Power Regulators

(needed in Lab 3: Measuring Hardware Power Using the KC705 Evaluation Board), use the Texas
Instruments USB Interface Adapter. You can find information on the USB Interface Adaptor at
this location:

www.ti.com/lit/ml/sllu093/sllu093.pdf

Hardware Requirements for UltraScale Devices

e The hardware power measurements in UltraScale devices
(needed in Lab 4: Measuring Hardware Power Using the KCU105 Evaluation Board), require a
Xilinx Kintex® UltraScale FPGA KCU105 Evaluation Kit. You can find information on the
Evaluation Kit at the following location:

Xilinx Kintex® UltraScale FPGA KCU105 Evaluation Kit

e For power measurements through Maxim Digital Power Tool
(needed in Lab 4: Measuring Hardware Power Using the KCU105 Evaluation Board), use the
Maxim Power interface adapter.

You can find information on the interface adapter at the following location:

www.maximintegrated.com/en/products/power/power-switching/MAXPOWERTOOL002.html
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Locating Tutorial Design Files

1. Download the reference design files from the Xilinx website:
ug997-vivado-power-analysis-optimization-tutorial.zip
2. Extract the zip file contents into any write-accessible location.

This tutorial refers to the location of the extracted ug997-vivado-power-analysis-—
optimization-tutorial.zip file contents as <Extract Dir>.

i} IMPORTANT: You will modify the tutorial design data while working through this tutorial. Use
a new copy of the original data each time you start this tutorial.

The ug997-vivado-power-analysis-optimization-tutorial.zip file includes a readme file
which contains the details and version history of the design files along with the folders of 7 series and
UltraScale design files.

7 Series Tutorial Design Files

You can find a separate 7 series folder containing the 7 series tutorial design files in the contents of the
zip file.

The following table describes the contents of the 7 series tutorial design files:

Directories/Files Description

/src Contains the design HDL and testbench for the functional
simulation.

/src/dut_fpga.v Top module for the design.

/src/bram_tdp.v Other design blocks - synthesized module.

/src/bram_top.v

/src/dut.v

dut_fpga kc705.xdc Contains clocking and timing constraints for the design.

/src/testbench.v Testbench for simulating the design.

UltraScale Device Tutorial Design Files

You can find a separate UltraScale folder containing the UltraScale device tutorial design files in the
contents of the zip file.

The following table describes the contents of the UltraScale device tutorial design files:

Directories/Files Description

/src Contains the design HDL and testbench for the simulation.
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Directories/Files

Description

/src/dut fpga.v

Top module for the design.

/src/dut.v

/src/Cascade bram.v
/src/Noncascade bram.v
/src/bram_top cascade.v
/src/bram top noncascade.v
/src/bram_tdp cas.v
/src/bram _tdp noncas.v

Other design blocks.

dut fpga kcul05.xdc

Contains clocking and timing constraints for the design.

/src/testbench.v

Testbench for simulating the design.
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Lab 1: Running Power Analysis in the Vivado
Tools

Introduction

In this lab, you will learn about the Power Analysis and Optimization features in the Vivado® IDE. The
lab will take you through the steps of project creation and power analysis at the synthesis stage, using
the Vivado Report Power feature in vectorless mode. It will also demonstrate using the SAIF file
generated from behavioral simulation for Vivado Report Power Analysis.

You will analyze power in the Vivado IDE. Then you will examine some of the major features in the
Power Report window and closely examine some power specific Tcl commands. You will also learn to
create a SAIF file by simulating the design in the timing simulation stage using both the Vivado
simulator and Questa Advanced Simulator.

You will also learn how to achieve Power Optimization after opt design in the Vivado IDE. You will
examine the power optimization report and selectively turn power optimizations ON or OFF on specific
signals, nets, modules, or hierarchy.

Step 1: Creating a New Project

To create a project, use the New Project wizard to name the project, to add RTL source files and
constraints, and to specify the target device.

Note: Throughout this tutorial, Xilinx® 7 series example design is used to explain the process of
configuring, implementing, estimating the power through different stages, and using simulation
data to enhance the accuracy of the power analysis. For UltraScale™ device design, most of the
steps are similar to 7 series. Additional information, wherever necessary, is provided for UltraScale
devices.

e On Linux,

1. Go to the directory where the lab materials are stored:

cd <Extract Dir>/7 series (for7 series devices)

or
cd <Extract Dir>/UltraScale (for UltraScale devices)

2. Launch the Vivado IDE: vivado
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¢ Vivado 2018.1 - ] X

File Flow Tools Window Help Q- Quick Access

VIVADO' & XILINX

LL PROGRAMMABLE

HLx Editions

Recent Projects

Quick Start proect

C:/Users/venkatas/project_1
Create Project >

Open Project >

Open Example Project >

Tasks

Manage IP >
Open Hardware Manager >
Xilinx Tcl Store >

Learning Center

Documentation and Tutorials >

Tcl Console

Figure 1: Vivado IDE - Getting Started Page

e On Windows,
3. Launch the Vivado IDE:
Start > All Programs > Xilinx Design Tools > Vivado 2018.x > Vivado 2018.x
(x denotes the latest version of Vivado 2018 IDE)
4. As an alternative, click the Vivado 2018.x Desktop icon to start the Vivado IDE.

The Vivado IDE Getting Started page contains links to open or create projects and to view
documentation.

5. In the Getting Started page, click Create New Project to start the New Project wizard.

6. Click Next to continue to the next screen.

Power Analysis and Optimization www.xilinx.com Send Feedback 10
UG997 (v2018.1) April 4, 2018 I—\/_l


http://www.xilinx.com/
https://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG997&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Power%20Analysis%20and%20Optimization&releaseVersion=2018.1&docPage=10

& XILINX

ALL PROGRAMMABLE, Lab 1: Running Power Analysis in the Vivado Tools

¢ MNew Project @

Project Name

Enter a name for your project and specify a directory where the project data files will be stored. ‘

Project name: power_tutorial1
Project location: | C:ivivado_power_tutorial IZ'

v Create project subdirectory

Project will be created at: C:vivado_power_tutorial/power_tutorial1

Figure 2: Creating a New Project

7. In the Project Name page, name the new project power tutoriall and enter the project location
(C:\Vivado Power Tutorial). Make sure to check the Create project subdirectory option and
click Next.

8. In the Project Type page, specify the type of project to create as RTL Project, make sure to
uncheck the Do not specify sources at this time option, and click Next.

9. In the Add Sources page:
a. Set Target Language to Verilog and Simulator language to Mixed.
b. Click the Add Files button.

c. Inthe Add Source Files dialog box, navigate to the <Extract Dir>/7 series/src
directory for 7 Series devices or <Extract Dir>/UltraScale/src for UltraScale devices.

d. Select all of the Verilog (.v) source files, and click OK.

e. Inthe Add Sources page, change the HDL Source For the testbench. v file to Simulation
Only.
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¢ Mew Project @

Add Sources

Specify HOL, netlist, Block Design, and IP files, or directories containing those files, to add to your project. Create a new source ‘
file on disk and add it to your project. You can also add and create sources later.

+,
Index Mame Library HDOL Source For Location
@ 1 bram_tdpwv  xil_defaultlip  Synthesis & Simulation ~ C:vivado_power_tutorial/7_seriesisrc
w2 pram_topy  xil_defaultlib  Synthesis & Simulation = C:nivado_power_tutorial/7_seriesisrc
@@ 3 dutv ¥il_defaultlib  Synthesis & Simulation = Coivivado_power_tutorial/7_seriesisrc
@ 4 dut_fpgaw ¥il_defaultlip  Synthesis & Simulation = C:nvivado_power_tutorial/7_seriesisrc
@ 5 testbenchyv  xil_defaulllib  Simulation only ~  Chivado_power_tutorial/7_seriesisrc
Add Files | | Add Directories | | Create File

3Scan and add RTL include files into project
Copy sources into project

Target language: | Verilog R Simulator language: | Mixed A

Figure 3: Setting HDL Source Type for testbench.v (7 Series)

f. Verify that the files are added and Copy sources into project is checked. Click Next.
10. In the Add Existing IP (optional) dialog box, click Next.

11. In the Add Constraints (optional) dialog box, click Add Files and select dut fpga kc705.xdc in
the file browser. In the directory structure, you will find the dut fpga kc705.xdc file below the
/src folder.

For UltraScale devices, select dut fpga kcul05.xdc in the file browser. In the directory
structure, you will find the dut fpga kcul05.xdc file below the /src folder.

12. Click Next to continue.

13. In the Default Part dialog box, click Boards to specify the board for the target device and select
Kintex-7 KC705 Evaluation Platform for 7 Series or Kintex-UltraScale KCU105 Evaluation
Platform for UltraScale devices. Then click Next.

Power Analysis and Optimization www.xilinx.com Send Feedback 12
UG997 (v2018.1) April 4, 2018 [—\/—]



http://www.xilinx.com/
https://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG997&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Power%20Analysis%20and%20Optimization&releaseVersion=2018.1&docPage=12

& XILINX

ALL PROGRAMMABLE.

Lab 1: Running Power Analysis in the Vivado Tools

TIP: When you specify a Board, you are also specifying the part you are targeting for your
design, in this case an xc7k325tffg900-2 FPGA for 7 Series or xcku040-ffva156-2-e FPGA for

UltraScale devices.

14. Review the New Project Summary page. Verify that the data appears as expected, per the steps

above, and click Finish.

Note: It might take a moment for the project to initialize in the Vivado IDE.

4 power tutoriall - [Ci/vivado_power tutorial/power_tutoriall /power tutoriallxpr] - Vivado 20171

File Edit Flow Tools Window Layout View Help | “~ QuickAccess
=, >
Flow Navigator t3 B A PROJECT MANAGER - power_tutorial1

~ PROJECT MANAGER
£} Settings

Add Sources

Sources =
a = & + =

~ Design Sources (1

Project Summary

Settings  Edil
Language Templates
¥ |P Catalog 5

> Simulation Sources (1

5 @& dut fpga (cut fpgav) (i Project name:

Constraints (1 Project location:

Product family:

<

IP INTEGRATOR

power_tutorial1

C:Nivado_power_tutorial/power_tutorial1

Kintex-7

(BN BB F3
Ready

Default Layout -

?O0BX

v PROGRAM AND DEBUG

¥t Generate Bitstream

> OpenHardware Manager <

Project part: Kintex-7 KC705 Evaluation Platform (xc7k325tfg900-2)
Create Block Design Top module name: dut_fpga
OpenBlockDesian || |-zzmmmsszesneeme oo Target language Verilog
Hierarchy  Libraries Compile Order Simulator language Mixed
Generate Block Design
Properties ? 00X
v SIMULATION B
- bl
Run Simulation Display name Kintex-7 KC705 Evaluation Platform
Board part name: xilinx.com:kc705:part0:1.5
v RTL ANALYSIS Connectors:
> Open Elaborated Design Select an object to see properties Rep path: Ri/xbuilds/2017.1_daily_| 4ivivado/2017. | files
URL: www xilinx.com/kc709
v SYNTHESIS Board ovenview: Kintex-7 KC705 Evaluation Platform ~
>
P Run Synthesis
> Open Synthesized Design Tcl Console Messages Log Reports Design Runs x 7 00
a = 2 + %
¥ IMPLEMENTATION
Name Constraints ~ Status WNS  TNS WHS THS TPWS Total Power FailedRoutes LUT FF  BRAMs URAM DSP  Start  Elapsed Strategy
P Run Implementation . .
~ synth_1 constrs_1 Mot started Vivado Synthesis Defaults (Vival
> Openimplemented Design impl_1  constrs_1  Motstarted

Vivado Implementation Default

Figure 4: Project in Vivado IDE (7 Series)

15. In the Vivado Options dialog box (Tools > Settings > Tool Settings> Project), enter the tutorial
project directory in the Specify project directory box, so that all reports are saved in the tutorial

project directory. Then click OK.
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¢ Settings

Project Settings

¥

General
Simulation
Elabaoration
Synthesis
Implementation
Bitstream

IP

Tool Settings

L

» Window Behavior

Project

IP Defaults
Source File
Display
WebTalk
Help

Text Editor

3rd Party Simulators

Colors
Selection Rules
Shortcuts

Strategies

Lab 1: Running Power Analysis in the Vivado Tools

Project
Specify various settings related to projects. ‘

Default Project Directory
Startin directory (C:/Usersivenkatas)
Last project's directory

Home directory (C:/Usersivenkatas)
® Specify project directory: C:Jproj| E

Target Language

* Verilog VHDL

Recent
Reopen last project on startup
Mumber of recent projects to list. 10 :
MNumber of recent directories to list: 15 2

Number of recent files to list 10 2

‘ Cancel ‘ ‘ Apply ‘ ‘Bestore...

Figure 5: Setting the Project Directory

Now, the design is ready for Synthesis.
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Step 2: Synthesizing the Design

1. Click Run Synthesis in the Flow Navigator. In the Launch Runs Dialog box that appears click OK.

¢ Launch Runs @

Launch the selected synthesis ar implementation runs. ‘

Launch directory. = &5 <Default Launch Directory= hd

Options
® Launchruns onlocal host  Mumber of jobs: 4w

Generate scripts only

Dont show this dialog again

Figure 6: Launch Runs Dialog Box

2. The Synthesis Completed dialog box appears after synthesis has completed on the design.

-

Synthesis Completed @

o Synthesis successfully completed.

Next
Run Implementation
@ Open Synthesized Design

View Repors

Don't show this dialog again

Figure 7: Synthesis Completed Dialog Box
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ALL PROGRAMMABLE, Lab 1: Running Power Analysis in the Vivado Tools

3. Open the synthesized design by selecting Open Synthesized Design in the Synthesis Completed
dialog box and clicking OK.

Step 3: Setting Up the Report Power

The Vivado IDE allows you to specify input data to the Report Power tool to enhance the accuracy of
the power analysis.

In the Vivado IDE, you can configure thermal, environmental, and power supply options to mimic the
board level settings as closely as possible. For information on setting these options, see the Vivado
Design Suite User Guide: Power Analysis and Optimization (UG907).

1. In the main menu bar, select Reports > Report Power.

2. Examine the Environment tab in the Report Power dialog box (Figure 8).
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ALL PROGRAMMABLE. Lab 1: Running Power Analysis in the Vivado Tools
¢ Report Power X |
Estimate power consumption based on the netlist design and part xcku040-fva1156-2-2.
Results name: power_1
Environment  Power Supply Switching Dutput
Device Settings
Temp grade:
Process: maximum w
Environment Settings
Cutput Load: 0 : pF [0 -10000]
Junction temperature: 25679 °C
Ambient temperature: 25 : C
Effective 3JA 142 *CMW [0 -100]
Airflow: 250 w  LFM
Heat sink: medium (Medium Prof.. w
oA SCMW [0 -100]
Board selection: medium (107107 -
MNumber of board layers: 121015 (1210 15 Layer... w
+JB: G [0 -100]
< Mmoo o e e { T i cc P }
Legend
LUser Defined Calculated Default
Py

Figure 8: Report Power Dialog Box (Environment Tab)
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ALL PROGRAMMABLE.

Lab 1: Running Power Analysis in the Vivado Tools

3. In the Environment tab, set Process to maximum for a worst case power analysis. Examine the

Power Supply tab (Figure 9).

IMPORTANT: By default, Vivado Report Power uses nominal values for voltage supply sources.
Voltage is a large factor contributing to both static and dynamic power. For the most accurate
analysis, ensure that actual voltage values are entered for each supply. Similarly, ensure
temperature and other environmental factors match actual operating conditions.

¢ Report Power

Settings
Veeint:
Wecaux
Vecodsd:
Veocoz2h:
Vececol8:
Veecol15:
Weoco135:
Wecol12:
Vecauwx_io:
Vecbhram:
MGTAVECC:
MGTAW:
MGTVecaux

MGTZVecl:

Legend

User Defined

Results name: | power_1

Environment | Power Supply

1.000

1.800

3.300

2500

1.800

1.500

1.350

1.200

1.800

1.000

1.000

1.200

1.800

1.075

LA AN A N N NI E BN B IE B IE B IE I AR
= = = = = = = = = = = = =

ik
=

Calculated

Estimate power consumption based on the netlist design and part xc7ww485tfg1157-1.

Switching Qutput

0.970-1.030
[1.710-1.880]
3.000 - 3.450
[2.380-2.630
[1.710-1.900
[1.430 - 1.580]
[1.300 - 1.400]
[1.140-1.260]
[1.710-1.880]
0.970-1.030
0.950-1.050
1.140 - 1.260
[1.710-1.880]
[1.050-1.100]

Default

=

Figure 9: Report Power Dialog Box — Power Supply Tab
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ALL PROGRAMMABLE, Lab 1: Running Power Analysis in the Vivado Tools

4. In the Switching tab, expand Constrained Clocks and examine the constrained clocks in the design
(Figure 10).

IMPORTANT: Make sure all the relevant clocks in the design are constrained. All the design
clocks must be defined using create clock or create generated clock XDC
constraints, so that Report Power recognizes the clocks.

Default toggle rate is set to 12.5% and Default Static Probability is set to 0.5. This will be
applied to primary input ports (non-clock) and block box outputs.
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¢ Report Power @
Estimate power consumption based on the netlist design and part xc7 k325tTga00-2. ‘
Results name: | power_1
Environment Power Supply Switching Output
Simulation Settings -~

B

Simulation activity file (.saif) |

Default Activity Settings
Default toggle rate: 12.5 | [0-100]

Default Static Probability: 05| [0.0-1.0]

Enable Rate Settings

Static Probability Toggle Rate
BRAM Port Enable: [0.0-1.0] [0-1100]
BRAM Write Enable: [0.0-1.0] [0-100]
Bidi Output Port Enable: [0.0-1.0] [0-100]
Toggle Rate Settings
Static Probability Toggle Rate
Primary Qutputs: [0.0-1.0] [0 --100]
Logic
Reugisters: [0.0-1.0] [0-100]
Shift Registers: [0.0-1.0] [0-100]
Distributed RAMS: [0.0-1.0] [0 - 100]
LUTs: [0.0-1.0] [0-100]
DSPs: [0.0-1.0] [0-100]
Block RAMs: [0.0-1.0] [0 -100]
GTs
RX Data: [0.0-1.0] [0-100]
T¥ Data: [0.0-1.0] [0-1100]

~ Constrained Clocks

Clock Period
sys_clk_in_p 5ns
clk_0 5ns
clkoutd 10 ns
~
@

Figure 10: Report Power Dialog Box — Switching tab expanded to display Constrained Clocks
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ALL PROGRAMMABLE, Lab 1: Running Power Analysis in the Vivado Tools

5. In the Output tab of Report Power dialog box, specify the Output text file as power 1.pwr.

6. Specify the Output XPE file as power 1.xpe. After creating this file when Report Power runs, you
can import the file and results into the Xilinx Power Estimator (XPE). For information on importing
the file in to the Xilinx Power Estimator (XPE), see the Xilinx Power Estimator User Guide (UG440).

7. Specify the RPX file to write the results of the Report command in to the specified report file (RPX).
The saved RPX file can be reloaded using the Reports > Open Interactive Report command to
provide interaction/cross-probing with the open design.

¢ Report Power @

Estimate power consumption based on the netlist design and part xc7k325tfg00-2.

Results name: | power_1

Environment | Power Supply Switching Output
Qutput text file: power_1.pwr E
Qutput XPE file: power_1 xpe E
< Qutput RFX file: | Ci/proj/power_1.rpx |E

©
Figure 11: Report Power Dialog Box (Output Tab)
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ALL PROGRAMMABLE.

Lab 1: Running Power Analysis in the Vivado Tools

Legends in Report Power Tool

The following legends appear consistently in the Report Power tool:

Constraint

Simulation

User Defined

Estimated

Default

Displays when the Nets are defined as clock with timer constraints.

The defined frequency of a clock determines the switching activity.

Displays when the Nets with switching activities are derived from
simulation’s .saif file

Displays when the Nets with user set switching activities are
derived from set_switching_activity power tcl command.

Displays when the Nets with switching activities are generated by
report_power vectorless propagation engine.

Displays when the Nets include default switching activities. If you
use set_switching_activity on input port nets or on internal nets
before running report_power (vectorless propagation), the report
tool displays the default.

Step 4: Running Report Power

1. Click OK on the Report Power dialog box.

This runs the report power command.

2. Examine the Power Report power_1 generated in the Power tab of the results windows area in the

Vivado IDE.

TIP: Due to continuous accuracy improvements in the Vivado tools, the actual power numbers
you see might be slightly different than the ones that appear in the following figures.
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Power

Qa = & C
Settings
Summary (1.379 W)
Power Supply

~ Ulilization Details

Clocks (0.011W)
~ Signals (0.061
Data (0.061 W)

SetReset (0W)
Logic (0.011W)
BRAM (0.714 W)

VO (0.004 W)

Hierarchical (0.918 W)

Clock Enable (0W)

Clock Manager (0.117 W)

Summary

Power estimation from Synthesized netlist. Activity
derived from constraints files, simulation files or
vectorless analysis. Note: these early estimates can
change after implementation.

Total On-Chip Power:
Junction Temperature:
Thermal Margin

Effective SJA

Power supplied to off-chip devices:

Confidence level:

1379 W
274°C

57.6°C (30.3W)
18T

ow

Medium

Launch Power Constraint Advisor to find and fix

invalid switching activity

On-Chip Power
Dynamic: 0918w (6
Clocks:  0011W
67% Signals:  0.061W
Logic 0011 W
M BRAM: 0714 W
W amcw: 01T W
[[eF 0004 W
33%
Device Static: 0.461W

? -0 X

Figure 12: Power Report

3. Examine the power breakdown in the Power Report by block type (Logic, BRAM, 1/0, etc.).

4. Examine the power supply breakdown in the Power Supply view.

Settings

Summary (1
~ Utilization Details
Hierarchical (0.915 W)
Clocks (0.011W)

~ Signals (0.061 W)
Data (0.061 W)
Clock Enable (0WV)
SetReset (01)

Logic (0.011W
BRAM (0.714 W)

1O (0.004 W)

Clock Manager (0117 W)

Power Supply

Supply Source  Voltage (V)
Veeint 1.000
Vecaux 1800
Veco23 2.300
Veco25 2500
Veeol8 1.800
Vecols 1.500
Veco135 1.350
Veeo12 1200
Vecaux_io 1.800
Vecbram 1.000
MGTAVce 1.000
MGTAVE 1.200
MGTVeocaux 1.800
Vecade 1.800

Total (A)
1041
0152
0.042
0.000
0.000
0.000
0.000
0.000
0.000
0.066
0.000
0.000
0.000
0.030

Dynamic (A)
0745
0.067
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.054
0.000
0.000
0.000
0.000

Static (A)

0.296
0.085
0.042
0.000
0.000
0.000
0.000
0.000
0.000
0013
0.000
0.000
0.000
0.030

? —_0aXx

Default

Calculated

Figure 13: Power Report — Power Supply Display

5. Examine the Hierarchical breakdown of the power in the Utilization Details > Hierarchical view.
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Power ? 08X
QO =T & C W 7 Q = Hierarchical
Settings Utilization Mame Clocks (W) Signals (W) Data(W) Logic(W) BRAM (W) ClockManager (W) MMCM (W) 1O (W)
Summary (1.3 A ~ I 0.918 W (57% of total) 50 dut_fpga
Power Supply ~ EE— 0 795 W (53% of total) B dut (dut 0.009 0.061 0.061 0.011 0714 <0.001 <0001 =0.001
~ Utilization Details > B 0.079 W (5% of total) 2] gen_dut[o] br 0.001 0.006 0.006 0.001 0071 <0.001 <0001  <0.001
> B 0.079 W (5% of total) 3] gen_dut[1]br... 0.001 0.006 0.006 0.001 0.071 <0.001 <0001 =<0.001
Clocks (0.011 W) > H0.079W (5% of tolal) [@ gen_dut{2].br... 0.001 0.006 0.006 0.001 0.071 <0.001 <0.001  =<0.001
v Signals (0.061 W > W 0.079 W (6% of total [@ gen_dut{3] br 0.001 0.006 0.006 0.001 0071 =0.001 <0001 <0001
Data (0.061W) > B 0.079 W (5% of total) [ gen_duti4]br... 0.001 0.006 0.006 0.001 0.071 <0.001 <0001  <0.001
Clock Enable (0 W) > H0.079 W (5% of total) [ gen_dut[s]br... 0.001 0006 0.006 0.001 0.071 <0.001 <0001 <0.001
SelReset (0 W) > B O.078W (5% oftolal) @ gen_dut&]br... 0.001 0006 0.008 0.001 0.071 <0.001 <0001 <0.001
Logic (0.0711W) > B 0.079 W (5% of total) 2] gen_dut(7] br 0.001 0.006 0.006 0.001 0071 <0.001 <0001  <0.001
BRAN 0771410 > B 0.079 W (5% of total) 5] gen_dut[g].br... 0.001 0.006 0.006 0.001 0.071 <0.001 <0001  <0.001
Clock Manager (0.117 W)
b0 500 1 > B 0.079 W (5% of total) 3 gen_dut(a].br... 0.001 0.006 0.006 0.001 0.071 <0.001 <0001  =<0.001
1=0.001 W (=7% of total Leaf Gells (6
0124w ) Leaf Cells (15)

Figure 14: Power Report - Hierarchical Display

6. Examine the Clocks view and the various Signals views (Data, Clock Enable, and Set/Reset).

Power ? _0a X
QO T =2 C W " Q = clocks Constraint Calculated
Settings Utilization Name Frequency (MHz) Buffer Clock Buffer Enable (%) Enable Signal Bel Fanout Sites  FanoutiSite  Type
Summary (1.3 V) ~ 10.011W (1% oftotal) 3 dut_fpga
Power Supply > 10.009W (1 f total) I clkoutd 100.000 MN/A MNiA - MNIA 842 611 1378 NA

~ Utilization Details > 10.002W (=1% of tofal) I clk_0 200000 MiA MiA MNIA 2 2 1000 MiA

f total) o sys_elk_in_p 200000 MNiA NIA NIA 2 2 1000 NA

Hierarchical (0.915 W) > 1=0.001W (=
~ Signals (0.061 W)
Data (0.061W)
Clock Enable (0W)
SetReset (0 W)

Logic (0.011 W)
BRAM (0.71
Clock Manager (0117 W)
O (0.004 W)
Cpower s
Figure 15: Power Report - Clocks Display
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Step 5: Viewing the Power Properties

This step will show you how you can get the display of static probability and toggle rate for a signal in
property window.

1. Note the total power (Total On-Chip Power) in the Power Report Summary view.
2. Click the Set/Reset item in the Power Report.
3. Click on the dut/dut_reset signal.

Power ?_0ax
Q ¥ 2 C W 7 Q T setReset Attribute Estimated Calculated
Settings Utilization ~ Name Signal Rate (Mir/s) % High  Fanout Slice Fanout Clock  Logic Type
Summary (1379 W ~ 0w & dut_fpga
Power Supply ow I dutdut reset 0.000 0.000 530 0 clkoutd FFLUT
~ Utilization Details 0w T led_OBUF 0.000 100.000 3 0 clkoutd  FFIOLUT
Hierarchical (0.913 1/
Clocks (0 0111
~ Signals (0

Data (0.0 )
Clock Enable (0VV)
Logic (0.011 W)
BRAM (0.714 W)
Clock Manager (0.117 W)
110 (0.004

Figure 16: Power Report — Set/Reset Display

4. Note that there is a Power tab in the Net Properties window, displaying Net Properties for the
dut/dut_reset signal. Click on Load Power Properties to get the power information the first time.

Net Properties ? -0 a X
I dut_reset o
Qutput

Toggle rate: 0.0 %

Static probability: 0.0

Legend: Estimated

Edit Properties...

General Properties Connectivity Power  Aliases Cell Pins  Modes  Tiles Pips

Figure 17: Properties Window — Set/Reset Net Properties

5. Note the Toggle rate is 0% and the Static probability is O for the dut/dut_reset signal, which
indicates that Reset is always de-asserted in the design.
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Step 6: Editing Power Properties and Refining the Power
Analysis

Assume the Reset is asserted for 10% of the cycles in this design. Switching activity can be set
accordingly to re-estimate the power.

1. In the Net Properties window, click the Edit Properties button.

2. In the Edit Power Properties dialog box, change the Toggle rate to 4% and the Static probability
to 0.1.

¢ Edit Power Properties @
Set power properties for dut_reset. ‘
Output
Toggle rate: 4000 ) %

Static probability: [0.0-1.0]

Figure 18: Edit Power Properties Dialog Box

3. Click OK.

4. In the Net Properties window, observe that the Toggle Rate and Static Probability values turn a
different color to indicate that they are user defined.

Power Analysis and Optimization www.xilinx.com Send Feedback 26
UG997 (v2018.1) April 4, 2018 [—\/—]


http://www.xilinx.com/
https://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG997&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Power%20Analysis%20and%20Optimization&releaseVersion=2018.1&docPage=26

& XILINX

ALL PROGRAMMABLE, Lab 1: Running Power Analysis in the Vivado Tools
Net Properties ?_0aXx
T dut_reset -]
Qutput
Toggle rate: 40 %

Static probability: 0.1

Legend: User Defined

Edit Properties...

General  Properties Connectivity Power  Aliases CellPins  MNodes Tiles Pips

Figure 19: User Defined Color in Net Properties Window

You can also observe the equivalent Tcl command executed in the Tcl Console.

Tcl Console X Messages Log Reports Design Runs Power ?2_00
Q x 2 I @B B @
E Command: report_power -file C:/Users/Xiini/power_l.pwr -xzpe C:/Users/Xiinc/power_l.xpe -rpx C:/proj/power l.rpx -name power 1 i

| Running Vector-less Activity Propagation...

E Finished Running Vector-less Activity Propagation

! 0 Infos, 0 Warnings, 0 Critical Warnings and 0 Errors encountered.

" report power completed successfully

! set_switching activity -toggle rate 4.000000 -static_probability 0.100000 [get_nets dut/dut_reset]

Figure 20: Equivalent Tcl Command for Net Property Update

5. Rerun Report Power (Reports> Report Power).

6. Change the Output text File and Output XPE File in the Output tab to power 2.pwr and
power 2.xpe respectively.

7. In the Switching tab, set Switching Activity for Resets: to None. Then click OK.

8. In the Power window, note the change in total power reported in the power_2 report compared to
the power_1 report. The total power has decreased due to the change in the Signal Rate for the
dut/dut_reset signal. Since the signal is a reset signal, an increase in its activity will significantly
reduce the activity of other signals in the design. Note that the Signal Rate of the dut/dut_reset
signal is now color coded as being User Defined in both the properties window and the Set/Reset
view of the Power Report.
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Hierarchical (0895 \\

Tcl Console Messages Log Reports Design Runs Power x ?_00
Q £ 2 C H QX SetiReset User Defined Attribute Calculated
Settings Utilization MName Signal Rate (Mir/'s) % High Fanout  Slice Fanout  Clock Logic Type
Summary (1.358 W ~ 1 =0.001 W (=1% of total) 5 dut_fpga
Power Supply 1<0.001 W (<1% of total) I dut/dut_reset 4000 10.000 530 0 clkoutd FFLUT
 Utilization Details ow o led_OBUF 0.000  100.000 3 0 clkoutd  FFUQLUT

Clocks (0.011

~ Signals
Data (0 )
Clock Enable (01
Logic (0.01
BRAM (0.7 W/

Clock Manager (0.117 W)
IO (0.004 W)

power_1 X power_2 X

Figure 21: Power Report — User Defined Signal Rate

Xilinx recommends you to double-check the signal rates and percentage high (%high) values of high
impact I/O ports, control signals (such as resets and clock enables) and high fanout nets. This is an
opportunity to guide the Report Power tool to the right estimation scenario.

See the Vivado Design Suite User Guide: Power Analysis and Optimization (UG907) for more information

on switching activity.

TIP: In Tcl, use the set switching activity command to change the signal rate and static
probability of signals and use report switching activity to query the values that were

set on the signals.

set switching activity -signal rate 4 -static probability 0.1 [get nets dut/dut reset]

report switching activity [get nets dut/dut reset]

IMPORTANT: Switching activity can also be specified in terms of toggle rate. Toggle rate is
always associated with a clock. The primary ports can be associated with a specific clock using

the set input delayand set output delay commands. If no clock association is found,

Report Power will associate the ports with respect to the capturing clock.
For a clock of 100 MHz and a toggle rate of 4, the equivalent signal rate will be 4 MTr/s
(signal_rate = toggle_rate * Freq = 4 * T00MHz ).

Power Analysis and Optimization
UG997 (v2018.1) April 4, 2018

www.xilinx.com

| Send Feedback I

28


http://www.xilinx.com/
https://www.xilinx.com/cgi-bin/docs/rdoc?v=2018.1;d=ug907-vivado-power-analysis-optimization.pdf
https://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG997&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Power%20Analysis%20and%20Optimization&releaseVersion=2018.1&docPage=28

& XILINX
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Step 7: Running Functional Simulation with SAIF Output

Now that you have created a Vivado Design Suite project for the tutorial design, you can set up and
launch the Vivado simulator to run post-synthesis functional simulation. Simulation will generate a
switching activity values file (SAIF) that will enable you to do more accurate power estimation on your
design.

1. In the Flow Navigator, click Settings to open the Project Settings dialog box and set the simulation
properties in Simulation section.

2. In the Simulation section of Project Settings dialog box, note that the following Simulation defaults
are automatically set for you based on the design files:

Simulator language: Mixed
Simulation set: sim 1
Simulation top-module name: testbench

3. In the Elaboration tab of Simulation, make sure the xsim.elaborate.debug_level is set to typical,
which is the default value.
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¢ Settings IEI
Simulation

Project Settings Specify various settings associated to Simulation ‘
General
Simulation Target simulatar: Vivado Simulator W
Elaboration . -

) Simulator language: Mixed w

Synthesis
Implementation Simulation set: = 5im_1 A
Bitstream

- Simulation top module name: | testbench II‘

] +'| Clean up simulation files

Tool Settings
Project
IP Defaults Compilation Elaboration Simulation Netlist Advanced
Source File

) ¥sim.elaborate.snapshot
Display
WebTalk xsim.elaborate debug_level typical ~
¥sim.elaborate.relax <

Help

s Text Editor xsim.elaborate.mt_level auto A4
3rd Party Simulators xsim.elaborate load_glbl +

s Colors ¥sim.elaborate.rangecheck
Selection Rules xsim.elaborate sdf_delay sdfmax A4
Shortouts xsim.elaborate xelab.more_options
Strategies

» Window Behavior

Select an option above to see a description of it

5] [omm

Figure 22: Simulation Settings — Elaboration Tab

4. In the Simulation tab enter the SAIF file name as power tutorial func.saif for
xsim.simulate.saif. Observe that the xsim.simulate.runtime is 21000ns.

5. Click OK.
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#  Settings

Project Settings

»

General
Simulation
Elaboration
Synthesis
Implementation
Bitstream

IP

Tool Settings

w

L

With the simulation settings properly configured, you can launch the Vivado simulator to perform a

Project

IP Defaults
Source File
Display
WebTalk

Help

Text Editor

3rd Party Simulators
Colors
Selection Rules
Shortcuts
Strategies

Window Behavior

Lab 1: Running Power Analysis in the Vivado Tools

Simulation
Specify various settings associated to Simulation ‘
Target simulator: Vivado Simulator v
Simulator language: Mixed v
Simulation set: = sim_1 v
Simulation top module name: | testbench EI
<+ Clean up simulation files
Compilation Elaboration Simulation Netlist Advanced
x¥sim.simulate.tcl post
¥sim.simulate.runtime 1000ns
¥sim.simulate.log_all_signals +
¥sim.simulate.custom_tcl
¥sim.simulate wdb
¥sim.simulate.saif_scope
¥sim.simulate.saif power_tutorial_func.saif
¥sim.simulate.saif_all_signals
¥sim.simulate xsim.more_options
xsim.simulate.saif
SAIF filename
Ok ‘ | Cancel ‘ ‘ Apply | ‘ Restore...

Figure 23: Simulation Settings — Entering SAIF File Setting

post-synthesis functional simulation of the design.

Note: The power reporting and analysis are not performed at the RTL level. They are performed at

the gate level.
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6. In the Flow Navigator, click Run Simulation > Run Post-Synthesis Functional Simulation.

»  SIMULATION
Run Simulation

Run Behavioral Simulation

L) [
RTL ANALYSH Run Post-Synthesis Functional Simulation

» OpenElat Run Post-Synthesis Timing Simulation

~  SYNTHESIS
P Run Synthl___

Figure 24: Running Post-Synthesis Functional Simulation from Flow Navigator

When you launch the Run Post-Synthesis Functional Simulation command, the Vivado simulator is
invoked to run the simulation.

SIMULATION - Post-Synthesis Simulation - Functional - sim_1 - testbench

Scope Objects Untitled 1

a =z | = &4 Q o o W a a X « 4 M T o

e oo e " . - _m"\

~ LI testbench testbench Verilog M. % sys_clk_p 0 Logic
» @ dut_fpga dut_fpga Verilog M & sys_clk_n 1 Logic

@ giol glol Verilog M. « led 1 Logic
@ pass 1 Logic
¥ @ WATCHDO.. 100000 Array

< >v- >

Figure 25: Post-Synthesis Functional Simulation Window in the Vivado IDE

After the simulation completes, click x at the top right corner to close the simulation window.

Step 8: Incorporating SAIF Data into Power Analysis

The SAIF output file requested in the simulation run is generated in the project directory. To further
guide the power analysis algorithm we use this SAIF file.

1. Ensure the SAIF file requested is generated. Check to see that the SAIF file requested in the
simulation settings prior to running simulation appears in this directory:
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<project directory>/power tutoriall/power tutoriall.sim/sim 1/synth/
func/power tutorial func.saif

In the Flow Navigator window, click on Open Synthesized Design to expand options.
From the Synthesized Design options, select Report Power.

In the Report Power dialog box, set the Results name to power 3

v A W

In the Output tab of Report Power dialog box, make the following changes:
o Set the Output text File to power 3.pwr
o Set the Output XPE File to power 3.xpe

6. In the Environment tab of Report Power dialog box, make sure that the Process is set to
maximum.

7. In the Switching tab of Report Power dialog box, specify the SAIF file location.

¢ Report Power == ]

Estimate power consumption based on the netlist design and part xc7k325tfg200-2.

Results name: | power_3

Environment | Power Supply | Switching Output

Reset switching activity before report power

Switching Activity for Resets: | Mone w

Simulation Settings

Simulation activity file {.saif). { /sim_1/synthfunc/power_tutorial_func.saif jzl

Default Activity Settings
Default toggle rate: 125 | [0-100]
Default Static Probability: 0.5 [0.0-1.0]
Enable Rate Settings
Static Probability Toggle Rate
BRAMW Port Enable: [0.0-1.0] [0-100]
BRAM Write Enable: [0.0-1.0] [0-100]
Bidi Output Port Enable: [0.0-1.0] [0-100]
Toggle Rate Settings
Static Probability Toggle Rate
Primary Qutputs: [0.0-1.0] [0-100]
Logic
Registers: [0.0-1.0] [0-100]
Shift Registers: [0.0-1.0] [0-100]

Plindribdnd DA~ mon_4n o anne R

Figure 26: Specifying SAIF File Location
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8. Click OK in the Report Power dialog box.

The report power command runs, and the Power Report power_3 is generated in the Power tab
of the results windows area.

Power ? -0ax
Q = 2 CH Summary
Settings _
Power estimation from Synthesized netlist. Activity On-Chip Power
Summary (1.332 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Note: these early estimates can Dynamic: 0.869W (55%)
+ Utilization Details change after implementation.
Hierarchical (0.369 W) Total On-Chip Power: 1332W Clocks 0010W (1%
Clocks (0.01 ) ' 5t Signals:  0.043W  (5%)
. Junction Temperature: 274°C
(0.0 Logic 0.009 W (1%)
 Signals (0.0 Thermal Margin: 57.6°C (303 W) g '
0 BRAM 0685W (79%
Datz (0 i Effective 3JA 18°CW M sraw '
Clock Enable (=0.00 M vncu 0117w
R Power supplied to of-chip devices: 0W
SetReset (<0.001 W) X 11 0.005W  (0%)
Logic (0.000 W) Confidence level High 35%
BRAM (0.685 W) Launch Power Constraint Advisor to find and fix I
invalid switching activity Device Static: 0.463W (35%)

Clock Manager (0.117 W)
10 (D.005 W)

Figure 27: Power Report - Summary

Note: The SAIF annotation results are displayed in the Tcl Console. Make sure that all the design
nets are matched with simulation nets, to achieve better accuracy by including Simulation data.
For 7 series devices, the number of design nets and simulation nets may vary due to various
reasons. The most common reason s that their hierarchical separators are different. Sometimes,
the simulation nets may be lower down in the hierarchy level. However, they should match 100%.

Example: INFO: [Power 33-26] Design nets matched = 1894 of 1894

Tcl Console ¥ Messages Log Reports Design Runs Power ?
Q = = I 8B E @

| HWRRNING: [P
| WRRNING: [P

t dut/gen_dut[39].bram top_inst/bram inst/clkB. Please chec

0] Read saif is try: 2 ivities o and this will be ignored. Users shall manually specify cloc equ

INFQ: [Power 33-177] SAIF annotation done from file C:i/vivado_power_tutorial/power tutoriall/power_tutoriall.sim/sim 1/synth/func/power_tutorial func.saif
INFO: [Power 33-26] Design nets matched = 1894 of 1894

- report_power -file [C:/Users/xiinx/power_3.pwr] -xpe {C: /Users/Xiins/power_3.xpe} -rpx [C:/proj/power_3.rpx] -name [power_3}

| Command: report_power -file C:/Users/xiin:/power_3.pwr —xpe C:/Users/¥inx/power_3.xpe -rpx C:/proi/power_3.rpx -name power 3

| WRRNING: [P 33-33 itching pli: f s being f.

3 Resoluti problems, ple

. 0 Infos,

") report_power completed successfully

ocks defined using

using sdc tim

GUI from Tools > E

rrors encountered.

c

Figure 28: Tcl Console Log — Reading SAIF Data

9. Go to the I/0 view in the Power Report. Note that all the I/O port activity data has been set from
simulation data we specified. The data is color coded to indicate activity rates read from the
Simulation output file.
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Settings
Summary (1.232 W)
Power Supply

~ Utilization Details

Hierarchical (0.262W)

Utilization
~ 10.005W (1%
10.004W
> 10.001W(
1=0.001W (=1% of total)

Name 10 Type
3 dut_fpoa

¥ sys_clk_in_p HP

1§ fme_out HR

<4 gpio_out pass HR

< led HP

Clocks (0.01W) 1<0.001 W (1% oftotal)
~ Signals (0.0
Data (0. )
Clock Enable (<0.001V
SetReset (<0.001W)
Logic (0009 W
BRAM (0.52

Clock Manager (0.117 W)

i0 (0.005 W)

power_1 X | power_2 X

? _0ax
Simulation Constraint Calculated

O Standard ~ Drive Strength  InputPins  QuiputPins  Bidir Pins Signal Rate...
DIFF_SSTL. NIA 1 0 1] 400.000
LYCMOS33 12.000 0 10 o 1.000
LWCMOS33 12.000 0 1 1] 1.000
LYCMOS15 12.000 0 1 o 1.000
»

Figure 29: Power Report - 1/0 Display

10. Note the difference in total power numbers (Total On-Chip Power in the Summary view) between
a pure vectorless run in the power_1 results versus with the post synthesis functional simulation
data in the power_3 results. Also note that the dut/dut_reset signal rates are overwritten by

simulation SAIF data.

Power
a = =2 C H Q = SsetReset
Settings Utilization

~ 1=0.001W (=1% oftotal)
1 =0.001 W (=1% oftotal)
ow

Summary (1332 W
Power Supply
~ Utilization Details
Hierarchical (0,262 W)
Clocks (0.01 W)

~ Signals

Data (0. )
Clock Enable (=0.001W

SetReset (<0.001 W)

Logic (0.009 W)
BRAM (0.525 1)
Clock Manager (0.117 W)
1O (0.005 W)
< >
power_1 X | power_2 X  power_3 X

MName Signal Rate (Mir/s) % High Fanout Slice Fanout Clock Logic Type
5 dut_fpga

I dut/dut_reset 1000 26.250 530 0 clkoutd FFLUT

o led_OBUF 1000 73740 3 0 clkoutd  FF IO LUT

?_0ax

Simulation Calculated
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Lab 1: Running Power Analysis in the Vivado Tools

Step 9: Implementing the Design

This tutorial helps you understand Power Analysis with and without Power Optimization. In this step,

you will run Implementation without Power Optimization.

1.
2.

Power Analysis and Optimization

In the Flow Navigator, right-click on Implementation and select Implementation Settings.

In the Opt Design settings, select the NoBramPowerOpt option for —-directive and click OK.

»

b

H

|: ) :I &

¢ Settings

Project Settings

General
Simulation
Elaboration
Synthesis
Implementation
Bitstream

IP

Tool Settings

Project
IP Defaults

Source File
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Text Editor

3rd Party Simulators
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Selection Rules
Shortcuts
Strategies

Window Behavior
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Specify various settings associated to Implementation

Constraints

Default constraint set:
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Description:
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More Options
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Figure 31: Disabling Power Optimization
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3. In the Flow Navigator, click Run Implementation.

4. When prompted to Save project before launching implementation click Don’t Save.
¢ Save Project @

e Save project before launching implementation?

Data to Save

| Synthesized Design - constrs_1 - dut_fpoa_kc¥05.xdc

Daont Save Cancel

Figure 32: Click “Don’t Save” Here

Conclusion

In Lab 1, you have learned how to set the power analysis in the Vivado IDE. In lab 2, you will learn

about the timing simulation and its effect on the power analysis.
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Lab 2: Running Timing Simulation and
Estimating Power

Introduction

In this lab, you will learn about generating a SAIF file after running a timing level simulation using the
Vivado® simulator and Questa Advanced Simulator. The lab will take you through the steps for SAIF file
creation, running timing simulation, and estimating power using the SAIF data.

Step 1: Configuring and Running the Timing Simulation using
Vivado Simulator

1. In the Implementation Complete dialog box, select Open Implemented Design and click OK to
open the implemented design. When prompted to Save project before opening an implemented
design, click Don’t Save.

Now you are ready to set up and launch the Vivado simulator to run post implementation timing
simulation. You will set the timing simulation properties in the Vivado IDE, then run the timing
simulation.

2. In the Flow Navigator, click Settings and select Simulation tab to set the timing simulation
properties.

3. In the Project Settings dialog box, note that the following defaults are automatically set:
Simulation set: sim 1
Simulation top-module name: testbench

4. In the Elaboration tab, make sure that debug_level is set to typical, which is the default value.

5. In the Simulation tab set the SAIF filename xsim.simulate.saif to
power tutorial timing xsim.saif.

6. Set the xsim.simulate.saif scope to testbench/dut_ fpga.
7. Observe that the simulation run time xsim.simulate.runtime is 1000ns.

8. Click OK.
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Simulation
Elaboration
Synthesis
Implementation
Bitstream

> IP
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IP Defaults

Source File
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Text Editor

3rd Party Simulators
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Figure 33: Timing Simulation Settings — Simulation Tab

With the simulation settings properly configured, you can launch the Vivado simulator to perform a
timing simulation of the post implemented design.

9. In the Flow Navigator, click Run Simulation >Run Post-Implementation Timing Simulation.

~  SIMULATION

Run Simulation

~ RTL AMALYS
» OpenElz

~ SYNTHESIS
P Run Synt

Het Properties

Run Behavioral Simulation

Run Post-Synthesis Functi

onal Simulation

Run Post-Synthesis Timing Simulation

Run Post-iImplementation Functional Simulation

Run Post-lmplementation Timing Simulation

Figure 34: Running Post-Implementation Timing Simulation
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10. After the Vivado simulator has finished simulating the design, ensure that the SAIF file requested
has been generated. Check to see that the SAIF file requested in the simulation settings prior to
running simulation appears in this directory:

<project directory>/power tutoriall/power tutoriall.sim/
sim 1/impl/timing/power tutorial timing xsim.saif

SIMULATION - Post-lmplementation Simulation - Timing - sim_1 -testbench

Scope Objects Untitled 2
a = |= &4 Q & (o W @ Q@ I« 4 T &
Name Design Unit  Block Type Mame Value DataT.”™ 1,000 000 ns]|”™
~ 1} testbench testhench Werilog M W sys_clk_p 0 Logic
> 4@ dut_fpga dut_fpga Verilog M... b sys_clk_n 1 Logic S —SBBe....
@ aglbl albl Verilog W % led 1 Logic
& pass 1 Logic
> & WATCHDO.. 100000 Array
000186a0
~
< 2~

Figure 35: Post-Implementation Timing Simulation using the Vivado Simulator
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Step 2: Running Report Power in Vectorless Mode

1. In the Flow Navigator, select Open Implemented Design > Report Power to open the Report
Power dialog box.

You can also select Reports > Report Power from the main menu bar.

2. In the Report Power dialog box Environment tab, make sure the Process is set to maximum and
click OK.

The Report Power command creates a Power Report under the power_1 tab in the results windows
area.

3. Note the total power (Total On-Chip Power) in the power report Summary page (Figure 36).

Power ?_0aX
Q T £ C 7 summay
Settings
g Power analysis from Implemented netlist. Activity On-Chip Power
Summary {1.545 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1.080W  (T0%)
~ Utilization Details
Total On-Chip Power: 1.545W Clocks: 0.022 W ot
Hierarchical (1.08 W) Junction T N N 21% : i
Clocks (0.022 W) unction Temperature: : 70% Signals:  0.223W  (21%
+ Signals Thermal Margin: 57.3°C(301W) Logic: 0.000W 1%
Data (0223 W) Effective 34 18w MIBRAM  0705W (55%
Clack Enable (0 ) Pawer supplied fo off-chip devices: 0 W W MMCM:  0A1TW (1%
SebReset (=0.001 W Confidence level: Medium Vo 0004W (0%
Logic (0 Launch Power Constraint Advisor to find and fix St
BRAM (0.70 invalid switching activty Device Stafic  Q465W  (30%)
Clock Manager (0117
/O (0.004 W)

Figure 36: Running Post-Implementation Report Power in Vectorless Mode

Vectorless Analysis is done based on default switching activity specification on the primary ports and
the design clocks.

Refer to the Vivado Design Suite User Guide: Power Analysis and Optimization (UG907) for more
information on Vectorless Power Analysis.
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Step 3: Running Report Power with Vivado Simulator SAIF
Data

The project directory contains the SAIF output file requested in the previous timing simulation run. We
use this SAIF file — a "Switching Activity Interchange Format” file — to further guide the power analysis
algorithm.

1. In the main menu bar, select Reports > Report Power.
2. In the Report Power dialog box, specify the SAIF file location in the Switching tab.

The SAIF file, which was requested in the simulation settings prior to running timing simulation,
should appear here:

<project directory>/power tutoriall/power tutoriall.sim/
sim 1/impl/timing/power tutorial timing xsim.saif

3. Click OK in the Report Power dialog box.

After the Report Power command completes, the Power tab in the results windows area displays
Power Report power_2.

In the Tcl console, observe that the SAIF file is read successfully and that 100% of the design nets
are matched. This assures you that the generated SAIF file is correct and matched with all design

nets.
Power ? - 0aX
Q = & C 7 summay
Settings
9 Power analysis from Implemented netlist. Activity On-Chip Power
Summary (1.485 W) derived from constraints files, simulation files or
Power Supply vectorless analysis Dynamic: 1.019W  (69%)
~ Utilization Details
Total On-Chip Power: 1485 W . ooy
Higrarchical (1.019W) Junction T : 16 18% Clocks 0021W (2%
unction Temperature: . P
Clocks (0.021 1) pe 59% Signals:  0.182W  (18%)
« signals (¢ Thermal Margin 574°C(30.2W) Logic: 0.008W 19)
Data (0.192 W) Bffective SJA 18w W BRAI  0685W (67%)
Clock Enable (<0.00 ~ Power suppliedto off-chip devices: 0W M ovMch:  0TW (12%)
Confidence level High o 0.005W 0051
Launch Power Constraint Advisor to find and fix L
invalid switching activty Device Static. ~ DA46BW  (21%)
Clock Manager (0,117 W
1f0 (0.005 W)
4 *
impl_1(saved) X  power_1 X  power_2 X

Figure 37: Power Report with SAIF Data

4. Note the change in total power (Total On-Chip Power in the Summary view) in the power_2
report compared to the power_1 report. The total power estimated in the report generated with
SAIF file data will be different than the total power estimated in the vectorless run (power_1 results).

5. Examine the summary and block level (On-Chip Power) power distribution in the Summary view of
the Power Report.
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6. Go to the Utilization Details > Signals >Data view in the Power Report. Note that all the Signal
Rate data has been set from simulation data the SAIF file provided.

The data is color coded to indicate activity rates read from the Simulation output file.

Lab 2: Running Timing Simulation and Estimating Power

Power
Q ¥ £ C 7 Q T
Settings Utilization MName
Summary (1.485 W) ~ E0A82W (1 of total) ¥ dut_fpga
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Clock Enable (<0.00 10.001W
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Logic (0.0 10.001 W (<1
BRAM (0.665 10 10.001W
Clock Manager (0117 W
10 (0.005 10001 W (= of to I dut/gen_dut{9] bram_top_inst/addr_b[0]
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Figure 38: Power Report Signals > Data View - Simulation SAIF Data for Signal Rates

7. In the Summary view of the power_1 report (the report generated by the vectorless analysis), click

on Confidence level (High in Figure 39).

The Confidence Level is a measurement of the accuracy and the completeness of the input data that
the Report Power uses while performing power analysis.
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Notice that the Confidence Level is High for the vectorless analysis since less than 25% of internal
nodes are user specified for Internal Activity.

Internal Activity:

Characterization Data:

User specified more than 95% of inputs

? —0a X

Power
Q = £ C7 summany
Seftings .
g Power analysis from Implemented netlist. Activity On-Chip Power
Summary (1.545 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1.080W  (70%)
~ Utilization Details
Total On-Chip Power: 1.545W .
Hierarchical (1.08 21% Clocks:  0.022W
Junction Temperature: 27.7°C 70% Signals: 0.223W
~ Signals (0.223 Thermal Margin: 57.3°C(30.1W) Logic: 0.000W
Data (0223 ~ Enecive sl 18w W BRAM:  0705W
Clock Enable (C Power supplied to off-chip devices: 0W M uch: 01T W
SetiReset (0.0 Confidence level: Medium o- 0004w (0%
Logic (0.008 Launch Power Constraint Advisor to find an Confidence Level Details X
BRAM (0.7 invalid switching activity
' ' Design State: High
Clock Manager (0.1 Design is routed
1D (0.004 W) Clock Activity: High
|« I Y ] User specified more than 95% of clocks |
impl_1(saved) >  power_1 X power_2 X 110 Activity: High

User specified less than 25% of internal

nodes
High

Device models are Production

Figure 39: Confidence Level for Vectorless Power Analysis (power_1)

In the Summary view of the power_2 report (the report generated by the analysis for which you
specified a SAIF file as input), click on Confidence level (High in Figure 40).

Notice that the Confidence Level has increased to High, since more than 25% of internal nodes are

user specified for Internal Activity.
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Power ? -0 a X
Q X 2 C7 summay
Settings ) . . ;
Power analysis from Implemented netlist. Activity On-Chip Power
Summary (1.485 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic; 1.019W (FO%
~ Utilization Detail
flization Lietalls Total On-Chip Power: 1.485W Clocks: DOAW (2
Hierarchical (1.019 Junction T ; 7.6 18% = melt “
unction Temperature: . ’ . .
Clocks (0,021 P B9% Signals:  0.182W (18°
- . |
~ Signals (0.182 V Thermal Margin: A7.4°C(30.2W) Logic: 0.008 W 1o
Data (0182 W Effective 3JA: 18°CWwW 67% BRAM: 0BEEW (F7%
Clock Enable (= Power supplied to off-chip devices: 0W W mch: OA1TW  (12%
SetiReset (=00 Confidence level: High | qoog ey 0 005 W
Logic (0.008 V! Launch Power Constraint Advisor to find § Confidence Level Details X
BRAM (0 625\ invalid switching activity
! Design State: High
Clock Manager (0.1 Design is routed
0 (0.005 ¥ Clock Activity: High
< > User specified more than 95% of clocks
impl_1 (saved) X | power_1 X | power_2 X 110 Activity: High
User specified more than 95% of inputs
Internal Activity: High
User specified more than 25% of internal
nodes

Characterization Data: High
Device models are Production

Figure 40: Confidence Level for Power Analysis with SAIF Input (power_2)

Generating a SAIF File using Questa Advanced Simulator

The following steps will take you through the process of SAIF file creation, running timing simulation,
and estimating power using the SAIF data using Questa Advanced Simulator.

IMPORTANT: Make sure the Vivado Design Suite knows where to pick up the Questa Advanced
Simulator tool. You can either:
Manually set the path to ModelSim/Questa Advanced Simulator using the $PATH environment

variable
or

From the Tools > Settings > Tool Settings section, define the path to the simulator in the
Vivado IDE under the 3rd Party Tools tab: Questa Advanced Simulator install path.
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2. Click OK to define the path and generate compiled libraries.
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Lab 2: Running Timing Simulation and Estimating Power

Make sure the Compiled library location points to a valid location for the compiled Xilinx

simulation libraries.

To create new compiled libraries:

In the 3" Party Simulators tab, specify the Compiled library location to Questa Advanced
Simulator. Use the Compiled library location specified during the compiled library generation and

enter it in the Compiled library location field of 3" Party Simulators tab. It should point to the

compile simlib directory.

’
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P

Tool Settings

Project

IP Defaults

Source File

Dizplay

WebTalk

Help

Text Editor

3rd Party Simulators
> Colors

R

Selection Rules
Shortcuts

Sirategies

-

‘Window Behavior

3rd Party Simulators
Specify install paths and default compiled library paths. Default compiled liorary path will be ‘
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Install Paths
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Step 1: Configuring and Running Timing Simulation in
Questa Advanced Simulator

Now you are ready to set up and launch the Questa Advanced Simulator to run post-implementation
timing simulation. You will set the timing simulation properties in the Vivado IDE, and run the timing
simulation.

1. In the Flow Navigator, right-click Simulation to select Simulation Settings. Set the timing
simulation properties.

2. In the Simulation Settings tab, set the Target simulator to Questa Advance Simulator.

3. Click Yes to change your target simulator to Questa Advance Simulator.

P )

¢ Target Simulator @

o Questa Advanced Simulator requires that Xilinx libraries are pre-compiled.
You can compile Xiling simulation libraries by going to tools menu and clicking
on compile simulation libraries. Make sure that the compiled library location
in simulation setings menu is pointing to the correct file. To confirm
the status ofthe compiled libraries run report_simlib_infa Tcl command.

Ok to change your target simulator to *Questa Advanced Simulator?

Figure 42: Simulation Settings — Changing the Target Simulator

4. Set the questa.simulate.saif to power tutorial timing questasim.saif.
5. Set the questa.simulate.saif scope to testbench/dut_ fpga.

6. Note that the questa.simulate.runtime is 1000ns.
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Simulation
Project Settings Specify various settings associated to Simulation ‘
General
Simulation Target simulator: Questa Advanced Simulator w
Elaboration ) -
) Simulator language: Mixed L2
Synthesis
Implementation Simulation set: i sim_1 L2
Bitstream ) )
s P Simulation top module name: | testbench E
- ¥ Clean up simulation files
Tool Settings
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IP Defaults
Source File - . - ] ; .
Compilation Elaboration Simulation Netlist Advanced
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| ~
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Figure 43: Configuring SAIF file Settings

7. Click OK. With the simulation settings properly configured, you can launch the Questa Advanced
Simulator to perform a timing simulation of the design.

8. In the Flow Navigator, click Run Simulation > Run Post-Implementation Timing Simulation.
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v SIMULATION Net Properties

Fun Simulation

Fun Behavioral Simulation

¥ RTL AMALYS _ _ _ _
Fun Post-Synthesis Functional Simulation

» Open Elz o _ _
Fun Post-Synthesis Timing Simulation
v  SYNTHESIS Fun Post-Implementation Functional Simulation
Run Post-Implementation Timing Simulation
P Run Synt . g

Figure 44: Running Post-Implementation Timing Simulation

A separate Questa Advanced Simulator GUI opens and starts simulating the design.

9. After the Questa Advanced Simulator has finished simulating the design, make sure the SAIF file
requested has been generated. Check to see that the SAIF file requested in the simulation settings
prior to running simulation appears in this directory:

<project directory>/power tutoriall/power tutoriall.sim/
sim 1/impl/timing/power tutorial timing questasim.saif

Step 2: Running Report Power in Vectorless Mode

IMPORTANT: If SAIF based report power has already been run in this session, run the
reset switching activity -all command in the Tcl Console. This will clear the SAIF
data in the power engine from the earlier runs.

1. Close any open Report Power views.

2. In the Flow Navigator, select Implemented Design > Report Power to open the Report Power
dialog box.

Alternatively, select Reports > Report Power in the main menu bar.
3. In the Report Power dialog box, make the following settings:
o Specify the Results name as power 1
o Inthe Environment tab, Set the Process to maximum
o In the Switching tab, leave the Simulation activity file empty

4. Verify that all the input settings are correct and click OK.
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The Report Power command creates a Power Report under the power_1 tab in the results windows
area. Note that the total power for Vectorless Analysis runs with default switching rates.

Power ? -0 a X
Q = = ' Summary
Settings onChi
Power analysis from Implemented netlist. Activity n-Chip Power
gummary (1.435 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1.019W  (69%)
~ Utilization Details
Total On-Chip Power: 1.485W . —
Hierarchical (1.012 P 18% Clocks:  0.021W  (2%)
Clocks (0.021 W) Junction Temperature: 27.6 °C £9% Signals: D182W  (18%)
~ Signals (0182 W) Thermal Margin: 57.4°C(30.2W) Logic: D.00BW  (1%)
Data(0.132w) ~ Effeciive 3JA 1.8 M ERAM:  0.B85W (57%)
Clock Enable (- Power supplied to off-chip devices: 0W B uvcH: DATW (12%)
Set/Reset (=0.0 Confidence level: High 110: D.005W  (0%)
Logic (0.005 W) Launch Power Constraint Advisor to find and fix ks
BRAM (0.685 W) invalid switching activity Device Static: 0ABEW  (31%)
Clock Manager (0.1
1/C (0.005 W)
% 3

impl_1 (saved) X  power_1 X

Figure 45: Power Report — Vectorless Mode Run
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Step 3: Running Report Power with Questa Advanced
Simulator SAIF Data

The SAIF output file requested in the simulation run has been generated under the project directory.
We use this SAIF file — a "Switching Activity Interchange Format” file — to further guide the power
estimation algorithm.

1. In the main menu bar, select Reports > Report Power.
2. In the Report Power dialog box, specify the SAIF file location in the Switching tab.

The SAIF file, which was requested in the simulation settings prior to running simulation, should
appear here:

<project directory>/power tutoriall/power tutoriall.sim/
sim 1/impl/timing/power tutorial timing questasim.saif

3. Click OK in the Report Power dialog box.

The Report Power command runs, and the Power Report power_2 is generated in the Power tab of
the results windows area.

Power ? —-0a X
Q = & C ? summary
Settings On-Chip P
Power analysis from Implemented netlist. Activity n-Lhip Fower
R derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1019W  (69%)
~ Utilization Details Total On.Chin P 1.485 W
otal On-Chip Power: . - ooz
Hierarchical (1.019 W) p 18% Clocks:  0.021W  (2%)
Clocks (0,021 W) Junction Temperature: 276°C 69% Signals-: 0482W  (18%)
« Signals (0.132 W) Thermal Margin: 57.4°C (30.2W) Logic: 0.008 W
Data (0,182 W) Effective SJA 18w W BRAM:  D0.685W
Clock Enable (=0.00 Power supplied to off-chip devices: 0W M mmcH: 01T W )
SetReset (0W) Confidence level High Jio: 0.005W (0%
Logic (0.005 W) Launch Power Constraint Advisor to find and fix i
BRAM (0.685 W) invalid switching activity Device Static: ~ 0.486W  (31%)
Clock Manager (0,117 V!
/0 (0.005 W
< >

power_2 X  power_1 X

Figure 46: Power Report - With SAIF File Data

4. In the Tcl console, observe the read_saif results. This shows the percentage of design nets matched
with simulation SAIF. This is important for accurate power analysis.

5. Go to the Signals > Data view in the Power Report and scroll to the right. Note that all the Signal
Rate data has been set from simulation SAIF data you provided.
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The data is color coded to indicate activity rates read from the Simulation output file.

Power ? _0a X
Q T & C 7 QO T Data Simulation Calculated
Setings Utilization Name signal Rate (Mtr's) % High  Fanout  Slice Fanout €
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Figure 47: Signals > Data View with SAIF File Data

6. Note the change in total power (Total On-Chip Power in the Summary view) in the power_2
report compared to the power_1 report. The total power estimated in the report generated with
SAIF file data will be different than the total power estimated in the vectorless run (power_1 results).

Conclusion

In Lab 2, you have learned how to generate a SAIF file after running a timing level simulation using a
Vivado Simulator and Questa Advanced Simulator.

In Lab 3, you will learn about basic hardware power measurement technique using the KC705
Evaluation Board and correlating the hardware power numbers with the numbers generated by Vivado
Report Power.
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Lab 3: Measuring Hardware Power Using the
KC705 Evaluation Board

Introduction

In this lab, you will learn about basic hardware power measurement technique and correlating the
hardware power numbers with the numbers generated by Vivado® Report Power using KC705
evaluation board for 7 series devices. The lab will take you through the steps for setting up the
hardware measurement, programing a bit file using Vivado Hardware Manager and power
measurement through Texas Instruments (Tl) Fusion Design Software. It also includes Junction
Temperature reading from Vivado System Monitor.

Step 1: Generating a Bit File from the Implemented Design
(Non-Power Optimization)

1. In the Vivado Design Suite, open the 7 series Implemented design.
2. In the Flow Navigator, click Generate Bitstream.

The Bitstream Generation Completed dialog box appears after the bitstream has been generated.

Bitstream Generation Completed @

o Bitstream Generation successfully completed.

Next
View Reports
@ Open Hardware Manager

Generate Memory Configuration File

Dont show this dialog again

Figure 48: Bitstream Generation Completed Dialog Box
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3. Open the Hardware Manager by selecting Open Hardware Manager in the Bitstream Generation
Completed dialog box and clicking OK.

Step 2: Setting Up the KC705 Evaluation Board

IMPORTANT: This project is created for the KC705 Rev 1.0 Evaluation Board. The pin constraints
are set based on this Evaluation Board. If you are using any other Revisions, update the XDC file
dut fpga kc705.xdc with the correct pin constraints.

1. Connect the Digilent Cable (or Platform USB Cable) for Programming.
2. Connect the Tl USB Interface Adapter to the PMBus port on the KC705 Evaluation Board.

3. Connect the Power Cable.

© @ ®

JuBWINIISU| SEXa]
n

X14505

Figure 49: KC705 Hardware Setup
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Evaluation Board

4,

www.ti.com/tool/fusion_digital_power_designer

Lab 3: Measuring Hardware Power Using the KC705

Install the Tl Fusion Digital Power Designer software on the PC from this location:

Step 3: Setting Up the Fusion Digital Power Designer

Software

1. Power ON the KC705 Evaluation Board.

2. Open the Fusion Digital Power Designer.

The software detects the USB adapter and brings up the GUI.

File Device Tools Help UCD9248 @ Address 52d -Rail #1
Configure [ Vout Canfig ‘[ Tout,Vin, Temp Config |[Other Config || Phase/Rail Config |[ GPIO Confia |
Sequence On and Off Timing | [Ucp9248 @ 52d - Rail #1
At write on rail ar 350 e — Voltage Setpoint, Margins, and Limits
device change 3.00 Vout Max: 1600 F] v
. 250 Rail #4 ) Rail #1
= .
g 2.00 s m Rail #1 Over Fault: 1150 v 15.0 % OV Response
Store RAM To Flash ] 3 1504 i = QOver Warn: 1.100 (v 10.0F %
1.00 Rail #2 Raill £3
Resmeﬂashmw] 050 Margin High: 1.050 v 5.0 %
0.00 Vout: 1000 B v
o 2 4 6 8 0 12 14 16 18 20 2 4 26 28 =
- Margin Low: 0.950 (%] v 5.0 % Synchronize
—— Time (msec) g & B SR
Copy Rail/Design ] Under Warn: osoo v -10.0F % PG to Vout
Plot: Select Rail to Edit Review in Larger Window ] Under Fault: 0.850 v | 1505 % UV Respanse
@ A
:) Soft Start On Delay Dependendes (Direct A Qver CurrentILV: oemByv  -130[]%  OCLVResponse
() 50t 5top 1
® =
Qe UCD9248 @ 52d 2 1.800 1.620 1.530 0.0 5.0 5.0 L0 VIN_ON @#6.000V, VIN_OFF Power Good On: 0.500 E v -10.0 E %o
Show rail labels UCD9248 @ 52d 3 Rail #3 3.300 2970 2805 0.0 50 40 10 VIN ON@6.000V, VIN OFF | Power Good OFF: nesofEv | -15.00 %
O Shluw current device UCD9248 @ 52d 4 2500 1700 1.650 00 50 3.0 1.0 VIN_ON @6.000 V, VIN_OFF| |
an
v UCD9248 @53 1 2500 2250 2135 00 50 10 L0 VIN_ON @6.000 V, VIN_OFF OnjOff Config: %00 (Always Converting)
UCD9248 @ 53d 2 1500 1350 1275 00 50 0.0 1.0 VIN_ON @86.000V, VIN_OFF T rurn On Tm Turn OFf Timing
UcDo248 @ 53d 3 L1000 0300  0.850 00 50 7.0 L0 VIN_ON @6.000 V, VIN_OFF | Turn On Delay: 0.0/ ms || T O Delay: ol ms
UCD9248 @53 4 1200 1080 1020 00 50 8.0 1.0 VIN_ON @86.000V, VIN_OFf
UCD9248 @ 54d 1 2000 1800 1700 0.0 50 2.0 1.0 VIN_ON @6.000 V, VIN_OFF || s 5:0[]ms | | Fall Tme: 1.0[]|ms
RN =
i Tips &Hints PMBus Log
.2 Design .
TOFF_MAX_WARN_LIMIT [0x66,Rail #1]
; _ Sets an upper limit on how long the unit can attempt to power down the output without
-/ Monitor reaching 12, 5% of the output voltage programmed at the time the converter is turned off.
A value of 0x7FFF means that there is no limit and that the unit waits indefinitely for the
1 status autput voltage to decay.
£, Security PMBus Log | =
Fusicn Digital Power Designer v1.8.325 [2013-05-07] | UCD3248 Firmware v5.8.0.11400 @ Address 52d | USB Adapter v1.0.14 [PEC; 400 kHz] &3 Texas InsTRUMENTS | fusion digital power

Figure 50: Fusion Digital Power Designer
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Step 4: Programming the Bitstream

1. Power up the KC705 Evaluation Board.
2. In the Vivado Hardware Manager, click Open Target in the green alert bar and select Open New
Target.
HARDWARE MAMNAGER - unconnected
0 Mo hardware target is open. Cpentarget

£’ Auto Connect
Hardware

Cpen Mew Target...

Mo content

Figure 51: Opening the New Hardware Target

3. In the Open New Hardware Target dialog box, click Next to go to the Hardware Server Settings.
4. Select the server to which the board is connected.
o If the board is connected to the local PC, select Local Server and click Next.

o If you are connecting to a remote server, see Connecting to a Hardware Target Using
hw_server in the Vivado Design Suite User Guide: Programming and Debugging (UG908).

When the hardware is detected successfully, the part information will be displayed in the Open New
Hardware Target dialog box.
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5. Verify the part information, then click Next and Finish.

¢ Open New Hardware Target

Select Hardware Target

Select a hardware target from the list of available targets, then set the appropriate JTAG clock (TCK) frequency. If you do not see the
expected devices, decrease the frequency or select a different target.

Hardware Targets
Type MName JTAG Clock Frequency
@ xilinx_tcf  Digilenti210203337377A 15000000 ~

Add Xilinx Virtual Cable (XVC)

Hardware Devices (for unknown devices, specify the Instruction Register (IR} length)

MName ID Code IR Length
@ xc7k325t 0 33651003 6

Hardware semver: localhost 3121

Cancel

Figure 52: Hardware Target Detected

6. In the Hardware window, right-click the part and select Program Device.
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HARDWARE MANAGER - localhostixiling_tcfDigilenti210203337377A

o There are no debug cores. Program device Refresh device

Hardware ? 006 X
Q = | < o
MName Status
~ B localhost (1) Connected
~ @l xling_tcfDigilent’2102033373..  Open
~ 8 xcTk325t_0 (1) Proarammad
£ ¥ADC (System Monitor) Hardware Device Properties...

Program Device...
Yerify Device...
(™ Refresh Device

Add Configuration Memary Device...

Boat from Caonfiguration Memaory Device

Program BBR Key...

Hardware Device Properties ? _ Clear BBR Key...

{8 xcTR325t_0 Program eFUSE Registers...
Name- XCTKI25E 0 E}_{E?mﬂ Spreadsheet...
Part: ¥CT k325t
ID code: 33651093
IR length: f
Status: Programmed

Programming file: | ect_1/project_1.runsfimepl_1/dut_fpc
Probes file:

User chain count: 4

General = Properties

Figure 53: Program Device

7. Select the bit file <project dir>/power tutoriall/power tutoriall.runs/impl 1/
dut fpga.bit and click Program.

8. After the program completes successfully, select XADC (System Monitor) in the Hardware window,
then right-click and select Dashboard, and then select New Dashboard.
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9. Click OK. The System Monitor window opens and plots Die Temperature (Junction Temperature) in

the Graph Window.

‘ HARDWARE MANAGER - localhost/ilink_tcfiDigilenti2 102033373774

@ There are no debug cores. Program device Refresh device

Hardware dashboard_1
Q = = & XADC (xcTK325t_0)
Name Status ”
2 o 4| =
~ B Iocalhost (1 Connscted S
= .
~ e xilin_{ciDigilent/2102033373..  Open S | ETemp 263°C
~ @ x7K3250(1 Programmed | 5 |EIVCCINT 0.808v
& XADC (S I
a8
< 2 §
System Monitor Core Properties ]
& XADC - -3 g
k3
Name:  XADC
Handle: localhost:312 tidlink_ciDigilent2102033373774
< >
General

Time (HHMMSS)

1.00

0.997

0.992

089

0.988

Figure 54: System Monitor - Junction Temperature Plot

Step 5: Measuring the Hardware Power Rails

1.

In the Fusion Digital Power Designer, select a rail in the Configure view and click Monitor.

| File Device Tools Help

UCD9248 @ Address 52d -Rall #1

)

Configure Vout Config [ Tout,Vin, Temp Config | Other Config | Phase/Rail Config | GPIO Config |
Sequence On and Off Timis )| [vcp9248 @ 52d - Rail #1
Auto write on rail or 3 Rail #3 [— Voltage Setpoint, M: d L
device change 3.00 1.600 =] v
2,50 —
~ =
2 2004 OV Response [
—_—— 5 i 2
| storeraMToFlash | g 0
_— 1.00 =
| Restore Flashto Ram | 0.50 \
0.
0 2 4 3 8 0 12 14 16 18 20 22 24 26 28 =
. Synchronize
: : Time (msec) margins imits/
[ copyRailjpesign - PG to Vout
Flot: Select Rail to Edit | Review in Larger Window (] 0850V UV Response ||
Device R; Vout Riss |OffDelay |Fall | Dependencies {Direct . k- 080 v OC LV Response [
1 VIN_ON @ 6.000 V, VIN_OF|
UCDS248 @ 524 2 5.0 1.0 VIN_ON @86.000 V, VIN_OFf 0.900 v
Show rail labels UCD9248 @ 52d 3 3.300 2970 2805 0.0 50 40 1.0 VIN_ON @6.000 V, VIN_OFF 0.850 v
[[] Show current device UCD9248 @ 524 4 2,500 1.700 1650 00 50 3.0 10 VIN_ON @6.000V, VIN_OFF | =
o
UCD9248 @ 53d 1 2500  2.250 2425 00 50 10 1.0 VIN_ON @6.000 V, VIN_OFf ox00 [+
UCDe246 @ 53d 2 1500 1350 1275 00 50 0.0 1.0 VIN.ON @6.000V, VIN_OFf et Tt
UCD9248 @ 53 3 Ral #3 1000 0500  0.850 00 50 7.0 1.0 VIN_ON @6.000 V, VIN_OFFf — Tum On Delay: Turn OFf Delay:
UCD9248 @ 53d 4 1.200 1.080 1020 0.0 50 8.0 10 VIN_ON @ 6.000 V, VIN_OFF
UCD9248 @540 1 Rail #1 2000 1800 1700 00 50 20 1.0 VIN_ON @6.000V, VIN_OFF ¥ e e
., Configure
Tips & Hints PMBUS Log (3]
Design
TOH_DELAY [0x60,Rail #1] 13:13:55.327: UCD9248 @ 54d: LSER_RAM_00 [MFR 10,0xDA]: wrote 1 [0x01] to RAM
. Sets the time, in ms, from when a start condition is received (as programmed by the 13:13:56.634: UCD3248 @ 52d: USER_RAM_DO [MFR 10,0xDA]: wrote 1 [0x01] to RAM
Monitor ON_OFF_CONFIG command) untl the output voltage starts to rise. 58,577: UCD9248 @ 53d: LSER_RAM_00 [MFR 10,05DA]: wrote 1 [0x01] to RAM
10,821 USE-5AA #1: CONTROLL now High
Status
Security PMBUs Log | E]

Fusion Digital Power Designer v1 8325 [2013-05-07] | UCD9248 Firmware v5.8.0.11400 @ Address 52d | USB Adapterv1.0.14 [PEC; 400 kHz]

3 Texas Instrumens | fusion digital power

Figure 55: Select a Rail to Monitor
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2. Configure the parameters to be monitored. An Output Power graph will be plotted in the Monitor

Lab 3: Measuring Hardware Power Using the KC705

£ - 1o f*]
|| File Device Tools Help UCD3248 @ Adress 524 -Ral 1 |
- — 1
 Monitor h Readings - Rail #1 L~ | Pout - output Power | |
T ——
ShowHide Plots: Vin: 12.000 v 50
[vin [Jn Tin: N/A A
O rin O vtrack Pin: WA W e e .
Clveut  [lvout(a fl| | virack: —y 120
[ 1out [ tout(ally
Vout: 1.005 V 00
Pout  []ExtTemp 1
Int Temp [ All Temp Lo
Doty Duty Cydle: .30 % &
\ /|| | Fan speed: RPM
(%) Fit Al Plots on Screen — o
O scalePots toScreen || | phase #1 1B8A st
Viidth @
200 =
. 09:20 09:40 10:00 10:20 10:40
Show Warn & Fault Marie 0
Limit Editors Tout #1: oK |
Show Value Labels Temp *1: oK UCD9248 Internal Temperature I @
on Plots Input #1: 0K 7
oML oK . A e vttt e gt Wu
polingRate: 500 = || | misc: oK 34°C
(mseq) Logged FIt #1: FLT
Mfr: 0K
Stop Paling SMBALERT#  Not Asserted
T [ | | clearLogged Fauts
..... B
) configs Control Line (USB) |
10
High Low
) Design | 2= o |
T Operation - Rail #1
- 0
1 09:20 09:40 10:00 10:20 10:40
) Status =
) Security 4PMBUS Log Messages Show PMBus Log Unique pen/dose settings for Configure, Desian, Monitor, Status, and Security (7] ‘
Fusion Digital Power Designer v1.8.325 [2013-05-07] | UCD9248 Firmuware 5 8.0.11400 @ Address 52d | USB Adapter v1.0.14 [PEC; 400 kHz] | 8 Texas insunaens | fusion digtl power

Figure 56: Monitor a Rail - Power and Junction Temperature

3. Repeat the steps above to monitor the power information for each rail supplied to the device. Note
that rail information is displayed in terms of Regulator address.

VCCINT
VCCAUX
VCC3V3
VADJ
VCC2V5
VCCIV5
MGT_AVCC
MGT_AVTT
1 VCCAUX_IO
VCCBRAM

N/A

MGT_VCCAUX

“ ISR A Y

0xEBDC

1.0V
1.8V
3.3V
2.5V
2.5V
1.5V
1.0V
1.2v
1.8V
1.0V
1.8V
N/A

0xEBDC
0xEBDC
0xEBDC
0xEBDC
0xEBDC
0xEBDC
0xEBDC
0xEBDC
0xEBDC
O0xEBDC

N/A

Figure 57: KC705 Rail Address Mapping
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4,

Note the Junction Temperature value either from the Vivado Hardware Manager or from the Fusion
Digital Power Designer.

Step 6: Estimating Vectorless Power with Junction
Temperature

For further Power Analysis, you can use the measured Junction Temperature and other thermal settings
to feed into Vivado Report Power for better accuracy.

1.

In the Vivado Design Suite, open the tutorial project and click Open Implemented Design to
display the implemented design.

In the Tcl Console, run the following command to reset any user defined or SAIF file defined
settings.

reset switching activity -all
In the main menu bar, select Reports > Report Power.

In the Report Power dialog box Environment tab, enter the Junction Temperature value supplied
by the hardware power measurement.

Set the Process to maximum.
In the Switching tab, make sure the Simulation activity file (saif) is blank.

Click OK.
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¢ Report Power

Estimate power consumption based on the netlist design and parn xcku040-fva1156-2-2.

Results name: |pnwer_1

Environment

Device Settings
Temp grade:

Process:

Environment Settings

Cutput Load:

< Junction temperature:

Ambient temperature:
Effective SJA:

Adrflow:

Heat sink;

LS

Board selection:

Mumber of board layers:

4JB:

Board temperature:

Legend

User Defined

Power Supply

Calculated

Switching | Qutput
maximurm w
0 : pF | 00007
M T o
C
1.42 “CAW [0-100]
250 | LFM

medium (Medium Prof...

*CAW [0-100]
medium (10"%10%) w
121015 (12 to 15 Layer... »
*CAW [0-100]
"C -55-100]

Default

Cancel

Figure 58: Report Power Settings — Updating Junction Temperature
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8. In the Power Report, observe that the power numbers increase slightly as compared to the
vectorless power analysis using a default Junction Temperature value. Note that the Junction
Temperature is now color coded as being user defined in the Power Report.

Power ? 0O a X
Q = = *  summary
Settings .
g Power analysis from Implemented netlist. Activity On-Chip Power
Summary (1.576 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1017W  (65%)
~ tilization Details
Total On-Chip Power: 1.576 W . \
Hierarchical (1.017 ) 230, Clocks: 0.024'W
Clocks (0,094 1) Junction Temperature: 34.0°C G5% Signals: 0232W
« Signals (0.232 W) Thermal Margin: 51.0°C (26.7W) Logic: 0.016W
Data (0,235 W Effective 3JA: 1.8 *CW B cRAM: 0.624 W
Clack Enable ( Power supplied to off-chip devices: 0OW B uCH: 0417 W
SetReset (0 Confidence level: Medium ey io: 0.004W
Logic (0.016 W) Launch Power Constraint Advisor to find and fix
BRAM (0.624 W) invalid switching activity . - P
e Device Static: 0559W (35%)
Clock Manager (0.
IO (0.004 W)
¢ G 2l o ____
power_1

Figure 59: Power Report — Vectorless Analysis with Junction Temperature Supplied

9. Similarly, you can overwrite the Junction Temperature setting and do a SAIF based power analysis.

Note the power numbers measured and estimated on non-power Optimized design.

Conclusion

In this lab, you have completed a Vivado Report Power analysis on post-synthesis and post-
implementation netlist designs without Power Optimization. You also experimented with hardware
power measurement using the KC705 Evaluation Board and with reading Junction Temperature for
software analysis.

In lab 4, you will learn to experiment with hardware power measurement using the KCU105
Evaluation Board and with reading Junction Temperature for software analysis.
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Introduction

In this lab, you will learn about the basic hardware power measurement technique and correlating the
hardware power numbers with the numbers generated by Vivado® Report Power using the KCU105
evaluation board for UltraScale™ devices. The lab will take you through the steps for setting up the
hardware measurement, programing a bit file using the Vivado Hardware Manager and power
measurement through the Maxim Digital Power Tool. It also includes the Junction Temperature reading
from the Vivado System Monitor.

Step 1: Generating a Bit File from the Implemented Design

1. In the Vivado Design Suite, open the UltraScale Implemented design.
2. In the Flow Navigator, click Generate Bitstream.
3. When prompted to Save project before generating bitstream, click Don’t Save.

The Bitstream Generation Completed dialog box appears after the bitstream has been generated.

Bitstream Generation Completed @

[0] Bitstream Generation successfully completed.

Mext

View Reports

@ Dpen Hardware Manager:

Generate Memory Configuration File

Don't show this dialog again

QK | | Cancel

Figure 60: BitStream Generation Dialog Box
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4. Select Open Hardware Manager in the Bitstream Generation Dialog box and click OK to open
the Hardware Manager.

Step 2: Setting up the KCU105 Evaluation Board

IMPORTANT: This project is created for the KCU105 Rev B Evaluation Board. The pin constraints
are set based on this Evaluation Board. If you are using any other Revisions, update the XDC file
dut fpga kcul05.xdc with the correct pin constraints.

1. Connect the Digilent Cable (or Platform USB Cable) for Programming.

2. Connect the MAXPOWERTOOLOO2# Interface Adapter to the PMBus port on the KCU105 Evaluation
Board.

3. Connect the Power Cable.

X18380-032418

Figure 61: KCU105 Hardware Setup
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4. Install the Maxim Digital Power Designer software on the PC from this location.

https://www.maximintegrated.com/en/design/tools/applications/evkit-software/index.mvp?id=1183

Step 3: Configuring the Maxim Digital Power Tool Software

1. Power ON the KCU105 Evaluation board.

2. Open the Maxim Digital Power Tool. The software detects the Interface adapter and brings up the
GUL.

| 0x0A

[ Dashboard [ 0x08 | OxOF [ Ox1l [ 0x12 [ 0x14 [ 0x15 [ 0x16 [ 0x18 [ 0x1B
MAX15301 MAX15303A400 | MAX15303A400 | MAX15303AA00 | MAX15301 MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15301
Product ~ MAX15301  MAXI5303AA00 MAX15303AA00 MAX15303AA00  MAX1S301  MAX15303AA00 MAX15303AA00 MAX15303AA00 MAX15303AA00  MAX15301 _g::’g““:x":g: =]
—— O0x18:MAX15303 ——
6
Use Hardware Enable E
4
Input Voltage (V) 11422 3
2
Output Current (A) 096 1
1]

1360
Internal Temperature (C)

oo 78 - | - sy ——

() () (¢) (¢} (¢} (¢} (¢} (o) (o) o s
Power Goad [+] [+] [+] [#] [-] [-] [-] 20
o (o) (o) O (o} (e} (e} O (s) (s] =

Vout (V)
8

Clear Faults [ Clear | Clear | Clear || Clear | Clear | Clear | Clear |[ Clar |[  Clear |[  Clear | e
0350 21 1800 =1 0350 21 1800 = 1800 = 1200 = 1000 2 1200 2| 1800 2| 3300 2w W
I 1180 = | 782 & | 1075 & ua & 288 5 | 1000 | s2E w75 E wo
202 232 177 232 235 188 183 188 232 = 2132 ° ® -

=] =] [ =1 =] =] =] =] =] =]
2497 | 1477 | 1988 | 796 | 511 | 511 | 19.88 | 1478 | 10235 | 3000 5 Start Up

202 =) 232 = 177 =l 232 =) 235 =) 188 =l 183 =) 188 =0 232 = 213 B S o For Devices) (Save Configuats

On Delay Time (ms) |

Off Delay Time (ms) |

Figure 62: Maxim Digital Power Tool

Step 4: Programming the Bitstream

1. In the Vivado Hardware Manager, click Open Target in the green alert bar and select Open New
Target.

2. In the Open New Hardware Target dialog box, click Next to go to the Hardware Server Settings.
3. Select the server to which the board is connected.
o If the board is connected to the local PC, select Local Server and click Next.

o If you are connecting to a remote server, see Connecting to a Hardware Target Using
hw_server in the Vivado Design Suite User Guide: Programming and Debugging (UG908).
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When the hardware is detected successfully, the part information will be displayed in the Open

New Hardware Target dialog box.

4. Verify the part information, then click Next and Finish.

’

Open New Hardware Target

Select Hardware Target
Select a hardware target from the list of available targets, then set the appropriate JTAG clock (TCK) frequency. If you do not see the

expected devices, decrease the frequency or select a different target.

Hardware Targets
Type MName JTAG Clock Frequency
& xilinx_tcf  Digilent’210251845034 15000000 -

Add Xilinx Virtual Cable (XVC)

Hardware Devices (for unknown devices, specify the Instruction Register (IR) length)

MName ID Code IR Length
@& xcku0d40_0 13822093 6

Hardware server: localhost3121

Cancel

5.

Figure 63: Detecting the Hardware Target

In the Hardware Devices window, right-click the part and select Program Device.
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HARDWARE MANAGER - localhostixiline_tcfDigilenti210251845034

@ There are no debug cores. Program device Refresh device

Hardware
Q =

MName

i

~ B localhost (1)

~ {8 xcku040_0 (1)

& SysMon (System Monil

Hardware Device Properties

{8 xcku040_0
MName: xcku040_0
Part: xcku040
1D code: 13822003
IR length: B
Status: Mot programmed

Programming file:

Probes file:

User chain count: 4

?

~ @ wiling_teiDigilent2102518450

S 4
R o )

Status
Connected

Open

klat Reoaramn

Hardware Device Properties...

Program Device...
Verify Device...

Refresh Device

Add Configuration Memaory Device...

Boot from Configuration Memaory Device

Program BBR Key...
Clear BER Key...

Program eFUSE Reagisters...

Exportto Spreadshest..

General Properties

TclConsole x Messages

Serial 'O Links

Serial 'O Scans

Figure 64: Program Device setup

6. Select the bit file from the implementation runs directory of the project which is created in Lab 2 for
UltraScale design <project_dir>/power_tutorial2/power_tutorial2.runs/impl_1/ dut_fpga.bit and click

Program.
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7. After the program completes successfully, select XADC (System Monitor) in the Hardware window,
then right-click and select Dashboard, and then select New Dashboard.

HARDWARE MANAGER - localhostixiling_tcfiDigilent210251845034

ﬂ There are no debug cores. Program device Refresh device

Hardware ? _0O0 X dashboard_2
Q = < o SysMon (xcku040_0})
Mame Status o + -
~ B localhost (1) Connected 2
~ B wiling_tcfiDigilent2102518450..  Open g B Temp 31.2°C
~ 8 xcku040_0 (1) Mot programim E
=

& Syshlon (System M
System Monitor Core Properties...

JTAG Scan Rate 3
Dashboard » | 4 NewDashboard..
Exportto Spreadsheet... dashboard_2

< — 1T T -

System Monitor Core Properties ? 00 X

& SysMon <= e |

Mame: SysMaon
Handle: localhost 212 14ilin_tcfDigilent2102518450345

Figure 65: Creating a New Dashboard

8. Click OK. The System Monitor window opens and plots Die Temperature (Junction Temperature) in
the Graph Window.
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Temperature (*C)

10:10:45 10:11:00

10:11:15 10:11:30
Time (HH:MM:55)

Figure 66: System Monitor- Junction Temperature Plot for UltraScale Device
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Step 5: Measuring the Hardware Power Rails

1. In the Maxim Digital Power GUI, select a rail to monitor the power information.

@ Maxim PowerTool™ (1.09.05) = =S
Dashboard [ 0x0A | 0x08 | ox0F | 0x11 | 0x12 | ox1a | 0x15 | 0xi6 | 0x18 | 0x1B )
MAX15301 MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15301 MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15301
Configuration | Monitor [ Faults Set T PMBus CDmmand] Permissions. [ Tools \
o w2 [ i s
Vout Margin High (V) | oss =] Input Voltage (V) 11875
Switching Frequency Set Paint (kHz) 400 =1 Switching Frequency (kHz) 400
Power Good On (V) 0.852 External Temperature (°C) 42
R— gl
| surupshdomTines s ©
On Dy Time () s02 (|| (0 s Caliration' )
On Rise Time (ms) ‘ 202 = EXT_TEMP_CAL-m 1.0033 %
Off Delay Time (ms) 2497 EXT_TEMP_CAL-b 0.00
Off Fall Time ms) | 202
I0UT_CAL_GAIN (mf) 0550
IOUT_CAL_OFFSET (A) 1199
=) Margin High, Ignore Faults ©) Margin High, Act on Faults
© Noma  ivanced Coniguration
=) Margin Low, Ignore Faults ) Margin Low, Act on Faults -
® Soft Stop © Tristate Stop Advanced Configuration
Save Configuration to File Load Configuration File to Device
| StoreUserAll || RestoreUserAll || Restere Maxim All_|[_ Restore Default All

Figure 67: Selecting a Rail to Monitor

2. In Configuration tab, you can observe the basic settings and device status.

3. Click Monitor tab to observe the voltage and current plots.
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@ Maxim PowerTool™ (1.09.05) o S|
Dashbaard [ I 0508 " 012 Oxld x5 0x16 [ Ox1B
MAX15301 MAX15303A400 | MAX15303AA00 | MAX15303A400 | MAX15301 MAX15303A00 | MAX153034400 | MAX15303A400 | MAX15303A400 | MAX15301

[ Configuration [[Monitor | Faults Set | PMBus Command | Permissions [ Tools

G i Vout (V): Min: 0.950 Max: 0.950 Avg: 0.950 VIN (V): Min: 11.875 Max: 11.875 Avg: 11.875

On/Off Config 0x16 —wour___ —-—--- VOUT FAULT LIMIT = VIN FAULT LIMIT
2.0
16
Vout Command (V) 0.950 wtr—
Vout Max (V) 1045 s 12
10
Tout Cal Gain 0.55 L O VU IO U SO )
H 0 —— § ]
= 5
e e A EE GNP E PP PP PP PP PR EREPEEPEP PEEPPPPEPPPEPEF FERESPES PSS P PSP
Input Voltage (V) 11875 ¢
2
Output Voltage (V) 0950 0o o
200 910 820 930 240 £50 200 210 g20 930
Output Current (4) 320 sample Sample
Switching Frequency (kHz) 401 lout {A): Min: 3.203 Max: 3.344 Avg: 3.262 Internal Temperature (C): Min: 48.563 Max: 43.625 Avg: 48.608
Internal Tempﬂah‘,-e Q) 48 L 10UT FAULT LIMIT —— TEMPERATURE  ----- TEMP FAULT LIMIT
External Temperature (°C) 43 L S S
LI e R B R =
o
Duty Cycle (%) 753 £
= 30 E 20
= @
Status = -4
E .E, 50
Fault Warning =20 =
g w
Vout Under Voltage [«] [} 10 E
E 20
Tout Over Current () Q) -
0 o
Vin Over Voltage [*) o 200 a1 220 330 940 830 300 310 520 330
Vin Under Voltage O (%) Sample Sample
Vout Qver Voltage [«] [} Stop Plotting |

Figure 68: Monitoring a Rail - Voltage and Current

4. Repeat the steps mentioned above to monitor the power information for each rail supplied to the
device.

Note that the rail information is displayed in terms of Regulator address.

RAIL VOLTAGE PMBUS ADDR
VCCINT 0.95Vv 0x0A
VCCAUX 1.8V 0x0B
VCCBRAM 0.95Vv OxOF
VCC1V8 1.8V Ox11
VADJ_1V8 1.8V 0x12
VCC1V2 1.2V 0x14
MGTAVCC 1V 0x15
MGTAVTT 1.2V 0x16
MGTAVCCAUX 1.8V 0x18
UTIL_3V3 3.3V Ox1B

5. Note the Junction Temperature value from the Vivado Hardware Manager (System Monitor).
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Step 6: Estimating the Vectorless Power with Junction
Temperature

For further Power Analysis, you can use the measured Junction Temperature and other thermal settings
to feed into Vivado Report Power for better accuracy.

6. In the Vivado Design Suite, open the tutorial project and click Open Implemented Design to
display the implemented design.

7. Inthe Tcl Console, run the following command to reset any user defined or SAIF file defined
settings.

reset switching activity -all
8. In the main menu bar, select Reports > Report Power.

9. In the Environment tab of Report Power dialog box, enter the Junction Temperature value
supplied by the hardware power measurement.

10. Set the Process to maximum.
11. In the Switching tab, make sure that the Simulation activity file (saif) is blank.

12. Click OK.
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¢ Report Power

Estimate power consumption based on the netlist design and part xcku040-fva1156-2-e.

=X

Results name: pnwer_1|

Environment  Power Supply Switching

Device Settings

Temp grade:

Output

Process: ( maximum

Environment Settings

Cutput Load:

F Y

< | Junction temperature: (

Ambient temperature:

0 - pF [0 -10000]
34 2 )-C
C

Effective JJA: 1.42 °C/NY [0-100]
Airflow: 250 w  LFM
Heat sink: medium (Medium Prof.. w
a5 “CMW [0-100]
Board selection: medium (10%107) w
Mumber of board layers: 12015 (12 1o 15 Layer... w
S4B “CMW [0-100]
Board temperature: C [-65 - 100
Legend
User Defined Calculated Default
@

Cancel

-
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Figure 69: Reporting Power Settings — Updating Junction Temperature

13. In the Power Report, observe that the power numbers increase slightly as compared to the

vectorless power analysis using a default Junction Temperature value.

Note that the Junction Temperature is now color coded as being user defined in the Power

Report.
Power ? _0aXx
- -~ >
Q x & C Summary
Settings - . . - : 2
Power analysis from Implemented netlist. Activity On-Chip Power
Summary (3.063 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1.850' W 1%
~ Utilization Details
Total On-Chip Power: 3.063W .
Hierarchical (1.85 ) . 50% Clocks: 0114 W
Clocks (0,114 1) Junction Temperature: 40.0 °C Signals: 0.385 W
« Signals | Thermal Margin: 60.0 °C (39.4W) Logic: 0.089 W
Data (0.385 W Effective SJA T.47Ch MeRAM:  1132W
Clock Enable Power supplied to off-chip devices: 0W M M 0125 W
SetReset (0 V Confidence level: Medium 0% 1o 0.004 W
Logic (0. ) Launch Power Constraint Advisor to find and fix
BRAM (1.122 W) invalid switching activity Device Static 1213W  (40%

Clock Mananer (1 ~
>

impl_1(saved) X power 1 X

14. Similarly, you can overwrite the Junction Temperature setting and do a SAIF based power analysis.

Figure 70: Power Report — Vector Analysis with Junction Temperature Supplied

Conclusion

In this lab, you have learned to experiment with hardware power measurement using the KCU105

Evaluation Board.

In lab 5, you will learn about using the Power Optimization features in the Vivado IDE.
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Introduction

In this lab, you will learn about using the Power Optimization features in Vivado® for 7 series devices.
The lab will take you through the steps for invoking Power Optimization after synthesizing the design. It
will also guide you on how to use the power optimization report, make decisions and selectively turn off
power optimization on signals, blocks, and hierarchies.

TIP: When you run Implementation on your design, the Vivado tools may perform BRAM power
optimizations by default during opt design. These optimizations will not affect performance,
and will have little impact on area and runtime. In the previous Lab, the default BRAM power
optimization was disabled (Step-9 of Lab1) by setting a NoBramPowerOpt directive to

opt design.

Step 1: Setting Up Options to Run Power Optimization

1. In the Flow Navigator, right click Implementation and select Implementation Settings.
2. In the Project Settings dialog box, select Implementation tab to make the following settings:
¢ In the Opt Design settings, set the ~directive option to Default.

BRAM optimization runs in the Default setting for Opt Design during Implementation. BRAM
optimization was disabled in the previous lab. It is now re-enabled when the design runs Power
Optimization.

¢ In the Power Opt Design settings, check the is_enabled box.

This ensures Power Optimization runs after opt design. Enabling the Power Opt Design
option prior to place design results in a complete power optimization to be performed. This
option yields the best possible power saving from the Vivado tools.
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¢ Settings

Project Settings
General
Simulation
Elabaration
Synthesis
Implementation
Bitstream

P

Tool Settings
Project
IP Defaults
Source File
Display
WebTalk
Help
» Text Editor
3rd Party Simulato
» Colors
Selection Rules

Shortcuts
Sfrategies
» Window Behavior ..
< »
|f';"|
B
3. Click OK.

Lab 5: Performing Power Optimization

Implementation
Specify various settings associated to Implementation ‘

Constraints

Default constraint set. | &= constrs_1 (active) w
Options
AL LT N UL T gy =
is_enabled +

icl.pre E‘
tcl.post E|
-verbose

-directive* MoBramPowerOpt w
Maore Options

~ Power Opt Design (power_opt_design)

is_enabled 4 |

tcl.pre

HiH

tcl.post

More Options
is_enabled
Optionally run this step as part of the flow. This step optimizes design to maximize power saving.

Ok ‘ | Cancel ‘ | Apply ‘ |Bestore...

Figure 71: Implementation Settings — Enabling Power Optimization
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4. In the Create New Run dialog box, click Yes to “Properties for the completed run ‘impl_1" have been
modified. Do you want to preserve the state of ‘impl_1" and apply these changes to a new run?”.

Create New Run @

Froperties for the completed run ‘impl_1" have been maodified.
Do you want to preserve the state of impl_1" and apply these changes to a new run?

|:| Don't show this dialog again

1=
ie]
7]
=
=]

Cancel

Figure 72: Create New Run Dialog Box

5. In the Create Run dialog box, set the Run Name to impl 2.
6. Click OK.

7. In the Flow Navigator, select Run Implementation. Click Don't Save when the Save Project window
pops up to save both Synthesis and Implementation constraints.

[ =

¢ Save Project @

o Save project before launching implementation?

Data to Save
+ | Synthesized Design - constrs_1 - dut_fpga_ ke 05 .xdc

+ | Implemented Design - constrs_1 - dut_fpga_kcy 05 xdc

Dont Save Cancel

Figure 73: Click “Don’t Save” Here

You are running Implementation with Power Optimization turned on.
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8. In the Implementation Completed dialog box, select Open Implemented Design and click OK. Click
Don't Save when the Save Project window pops up to save both Synthesis and Implementation
constraints.

Step 2: Running report power opt to Examine
User/Design Specific Power Optimizations

1. In the Flow Navigator, select Implemented Design.

2. In the main menu bar, select Reports > Report Power Optimization.

Tools Window Layout View Help

Floorplanning v 'ﬂ' Z
'O Planning »  3251Tga00-2
Timing b

Edit Timing Constraints

Power Constraints Advisor... 'n.

*1 Schematic

Show Hierarchy

Repornt
Edit Device Properties. ..

Create and Package MNew IP..
Create Interface Definition...
Enable Parial Reconfiguration. ..
Run Tcl Script...

Property Editor

Associate ELF Files...

Generate Memory Configuration File...

Compile Simulation Libraries...

Hilinx Tcl Store...

Custom Commands

™

" Language Templates

£} Settings...

Report Methodology...
Report DRC...

Report Moise. .

Repart Utilization...
Repaort Clock Utilization...
Report Power...

Report Power Optimization...
Report High Fanout Mets. .
Report Design Analysis..
Repaort 10

Report Clock Metworks...
Report |P Status

Timing [

B e N L LT

Figure 74: Generating a Power Optimization Report
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3. The Report Power Optimization dialog box appears, as shown in the following figure.

[ o]

¢ Report Power Optimization @

Report power optimization.

Results name: power_opt_1

Export to file:
Cutput file format:

<+ Openin anew tab

Ilrl-';-\'l
(2) 0K Cancel

Figure 75: Report Power Optimization Dialog Box

4. Enter power opt 1 for the Results name.

5. Ensure that the Open in a new tab option is checked.

6. Click OK. Alternatively, in the Tcl Console execute this Tcl command:
report power opt -name power opt 1

7. Observe the report power_opt_1 is generated in the Power Opt tab of the results windows area.
When the report opens, the Summary view is displayed in the report.

8. In the Summary view, note that 50% of the BRAMs are clock gated by the tool during Power
Optimization.

Create New Run @

Properties for the completed run impl_1" have been modified.
Do you want to preserve the state of impl_1" and apply these changes to a new run?

e

D Don't show this dialog again

Cancel

1=
o
0
=
=)

Figure 76: Power Optimization Report — Tool Gated BRAMs
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9. In the Power Optimization Report, select Hierarchical Information > BRAMs > Tool Gated
BRAMs and observe the BRAM cells and its CE ports which are gated by the tool during the power
optimization.

Step 3: Running report power to Examine Power Savings

1. In the main menu bar, select Reports > Report Power.
2. In the Report Power dialog box, make the following settings:
o Specify the Results name as power 1
o In the Environment tab, make sure the Process is set to maximum.
3. Click OK. Alternatively, in the Tcl Console execute this Tcl command:
report power -name power 1

4. In the Summary view of the Power Report, observe an approximately 100-200mW power savings
compared to the non-optimized power run in the previous lab.

You can generate a bitstream to program the hardware and measure its power, to observe the
power saving in hardware. See Lab 3: Measuring Hardware Power Using the KC705 Evaluation for
hardware power measurement instructions.

Power ? _0Oa X
Q = & C 7 summay
Settings - . ) o :
Power analysis from Implemented netlist. Activity On-Chip Power
Bummary (1.48 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1017 W (69%)
~ Utilization Details
Total On-Chip Power: 1.48W Clocks: 0.024 W
Hierarchical (1.017 . 23% ' ' '
Clocks (0 Junction Temperature: 27.6°C £9% Signals:  0.232W
« Signals (0 \ Thermal Margin: B7.4°C (30,2 W) Logic: 0.016 W
Data (0.232 W Effective SJA: 1.8 "Ciw B BRAM: 0.624 W
Clock Enable | Power supplied to of-chip devices: 0'W W v 0417 W
SetiReset (0 Confidence level: Medium 1o- 0.004W  (0%)
Logic (0.016 W) Launch Power Constraint Advisor to find and fix R
BRAM (0. invalid switching activity Device Static. 0463 W (31%)
Clock Manager (0.,
e — Ca
power_1

Figure 77: Power Savings with Power Optimization
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Step 4: Turning Off Optimizations on Specific Signals and
Rerunning the Implementation

In this step you will learn how to turn off the power optimization on specific BRAMs.

IMPORTANT: Power optimization works to minimize the impact on timing while maximizing

power savings. However, in certain cases, if timing degrades after power optimization, you can
identify and apply power optimizations only on non-timing critical clock domains or modules

using the set _power opt XDC command.

See the Vivado Design Suite User Guide: Power Analysis and Optimization (UG907) for more
information on the set power opt command.

Assume that this BRAM is in the critical path:

dut/gen dut[0].bram top inst/bram inst/mem reg 0 0
This step makes sure the tool does not gate this BRAM.

1. In the Tcl Console, type this command:
set_power_opt -exclude cells [get cells dut/gen dut[0].bram top_inst/bram inst/mem reg 0_0]
This will prevent the tool from gating this BRAM.

2. From the Flow Navigator choose Run Implementation, which in turn reruns
power opt design.
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3. Click Save in the Save Project dialog box to save the Synthesized Design and Implemented Design
constraints before launching implementation.

e

gl‘.:-'_p Save Project @

Igl Save project before launching implementation?

Data to Save

V| Synthesized Design - synth_1 - constrs_1 - dut_fpga_kc705. xdc

/| Implemented Design -impl_1 - constrs_1 - dut_fpga_kc705. xdc

| Implemented Design - impl_2 - constrs_1 - dut_fpga_kc705, xdc

| Save || Dion't Save || Cancel

Figure 78: Save Design Constraints Before Rerunning Implementation

Also, select Implemented Design - impl_2 in the Save Constraints Conflict dialog box to save the
changes in constraints from the set _power opt command.

gf‘ Save Constraints Conflict @

l There are unsaved changes to constraints set 'constrs_1' in multiple editors, Flease
% choose which changes to save.

Changes to Save
Synthesized Design - synth_1

Implemented Design -impl_1

@ Implemented Design - impl 2

Ok ] | Cancel

Figure 79: Saving Design Constraints for impl_2

4. In the Implementation Completed dialog box, select Open Implemented Design and click OK.
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Step 5: Running report_power opt to Examine Tool
Optimizations Again

1. In the main menu bar, select Reports > Report Power Optimization.

2. In the Report Power Optimization dialog box, type in the Results name as power opt 2.

Alternatively, execute this Tcl command in the Tcl Console:

report power opt -name power opt 2

3. In the generated report power_opt_2 in the Power Opt window, display Tool Gated BRAMs.

Power Opt
Qa = = C
General Information
Summary
Recommendations
~ Hierarchical Information
~ BRAMs
User Gated BRAMs
BRAM WRITE_MODE O
SRLs
~ 8lice Registers
User Gated Slice Regis
Tool Gated Slice Regis!
KPM URAMs

< bd
power_opt_1

Q. Tool Gated BRAMSs

Cell Name

mem_reg_0_0 (RAMB36E1)
mem_reg_0_0 (RAMB36E1)
mem_reg_0_1 (RAMB36E1)
mem_reg_0_1 (RAMB36E1)
mem_reg_0_2 (RAMB36E1)
mem_reg_0_2 (RAMB36E1)
mem_reg_0_3 (RAMB36E1)
mem_reg_0_3 (RAMB36E1)
mem_reg_0_4 (RAMB36ET)
mem_reg_0_4 (RAMB36E1)
mem_reg_0_5 (RAMB36E1)
mem_reg_0_5 (RAMB36E1)
mem_reg_0_& (RAMB36E1)
mem_req 0 6 (RAMB36E1)

CE Port

ENARDEN
ENBWREN
ENARDEN
ENBWREN
ENARDEN
ENBWREN
ENARDEN
ENBWREN
ENARDEN
ENBWREN
ENARDEN
ENBWREN
ENARDEMN
ENBWREN

CE NetName
dut/gen_dut[0].bram_top_instibram_instmem_reg_0_0_ENARDEN_cooolgate_en_sig_2

dut/gen_dut[0].bram_top_instibram_instmem_reg_0_0_ENBWREN_cooolgate_en_sig_11

dut/gen_dut[0].bram_top_instibram_instmem_reg_0_1_ENARDEN_cooolgate_en_sig_3

dut/gen_dut[0].bram_tep_instibram_instmem_reg_0_1_ENBWREN_cooolgate_en_sig_12

dut/gen_dut[0].bram_top_inst/bram_inst'mem_reg_0_2_EMNARDEN_cooolgate_en_sig_4
dut/gen_dut{0] bram_top_inst/bram_inst'mem_reg_0_2_EMNBWREN_cooolgate_en_sig_13
dut/gen_dut{0]. bram_top_instbram_instmem_reg_0_3_ENARDEN_cooolgate_en_sig_5
dut/gen_dut{0].bram_top_instbram_instmem_reg_0_3_ENBWREN_cooolgate_en_sig_14
dut/gen_dut{0].bram_top_instbram_instmem_reg_0_4_ENARDEN_cooolgate_en_sig_B
dut/gen_dut{0].bram_top_instbram_instmem_reg_0_4_ENBWREN_cooolgate_en_sig_15
dut/gen_dut[0] bram_top_instbram_inst'mem_reg_0_5_EMARDEN_cooolgate_en_sig_7

dut/gen_dut{0]. bram_top_inst/bram_inst'mem_reg_0_5_EMNBWREN_cooolgate_en_sig_16

dut/gen_dut{0] bram_top_inst/bram_instmem_reg_0_&_EMARDEN_cooolgate_en_sig_8
dut/gen dut/0] bram_top_instbram _inst/mem req_0 6 EMBWREN_ cooolgate en sig 17

Figure 80: Displaying Tool Gated BRAMs

4. Note that this BRAM is no longer in the list of Tool Gated BRAMs:

dut/gen_

Power Analysis and

dut [0] .bram top inst/bram inst/mem reg 0 O

Optimization
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Step 6: Saving Power using UltraScale BRAM in Cascaded
Mode

UltraScale architecture-based devices provide the capability to cascade the data out from one BRAM to
the next BRAM serially. This will enable the devices to create a deeper block RAM in a bottom-up
fashion. When used in cascaded mode, the power consumption is considerably low compared to the
BRAM used in non-cascaded mode.

1. Run the steps mentioned in Step 1: Creating a New Project shown in Lab 1: Running Power
Analysis in the Vivado Tools.

a. Inthe Add Source Files dialog box, navigate to the
<Extract Dir>/UltraScale/src for UltraScale devices.

b. In the Add Constraints (optional) dialog box, click Add Files and select
dut fpga kcul05.xdc in the file browser. In the directory structure, you will find the
dut fpga kcul05.xdc file below the /src folder.

c. Select the Kintex-UltraScale KCU105 Evaluation Platform (xcku040-ffva156-2-e FPGA),
click Next.

2. Review the New Project Summary page. Verify that the data appears as expected and click
Finish.

3. In the Vivado Options dialog box (Tools > Options > General), enter the tutorial project
directory in the Specify project directory box, so that all reports are saved in the tutorial
project directory. Then click OK.

4. Click Run Synthesis in the Flow Navigator.

The Synthesis Completed dialog box appears after synthesis has completed on the design.

5. Select Run Implementation in the Synthesis Completed dialog box and click OK.

6. After the Implementation completes, click Open Implemented Design.

7. You can see the automatically generated power report impl 1 inthe power tab, which shows
as a saved report. This is an autogenerated vectorless power report.

8. Note the total power (Total On-Chip Power) in the power report Summary page.
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Power ? _0&a X
Q = £ C Summary
Settings .
& Power analysis from Implemented netlist. Activity On-Chip Power
Summary (2 343 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1850 W (79%)
Utilization Detail % |
v Unilization Detalls Total On_Chip Power: 2340 W 6% Clocks: 0414w
Hierarchical (155 W) Junction T ; - 218
uncuon lemperature: - " .
Clocks (0114 W) pe 0% — Signals:  0.385W
 Signals (0 385 1) Thermal Margin T17°C (49.1W) Logic: 0.083W
Data (0,385 W) Effective 34 ratow WsRAN: 1132w
Clock Enable (0 W) Power supplied to off-chip devices: 0W W vnch 0175 W
SetiReset (0W) Confidence level: Medium 10: 0.004 W
Logic (0.029 W) Launch Power Constraint Advisor to find and fix 2484
BRAM (1.132 W) invalid switching activity Device Staic. ~ 0.499W  (21%)
Clock Manager (0.125 W,
1/ (0.004 W)
e
impl_1 (saved)
Figure 81: Power Report Summary
9. Select Hierarchical view in the Utilization Details option on the left panel and observe the
Cascaded and Non-cascaded BRAM power.
Power ?-0aX
Q = & C Q. X  Hierarchical
Settings Utilization Name Clocks (W) Signals (W) Data(W) Logic(w) BRAM(W) Clock Manager (V)
Summary (2.252 W) ~ 1853 W (79% of total) B dut_fpaa
Pawer Supply oftotal) @ dut(dut) 0.105 0393 0.393 0.089 1132 <0.0(
~ Ulilization Details > I 1152 W (49% [T Noncascade_bram (Moncascade_ 0.052 0173 0173 0.051 0875 =0.0(
ierarchical (1.853 W) > I 0.567 W (24 [@ Cascaded_bram (Cascaded_bram) 0.052 022 022 0.038 0257 <0.0(
Clocks (0.11W) W 0.131 W (6% of tatal) Leaf Cells (12)
 Signals (0.393 W) > 10.003W (=1% of tolal) [l in_diff_bufg (IBUFDS) <0.001 <0001 <0.001 =0.001 <0001 =0.0(
Data (0.3
Clock Enable (0]
SetReset (0 W)
Logic (0.089 W)
BRAM (1,132 W)
Clock Manager (0.125 W)
10 {0.004 W)
¢ —— ] L4
impl_2 {saved)

Figure 82: Cascaded and Non Cascaded BRAM Power view

10. You can see 50% to 60% saving in Cascaded BRAM compared to Non Cascaded BRAM.
11. Use the same steps as specified in Step 1, Step 2, and Step 3 to perform SAIF based power
analysis using Vivado Simulator.
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Conclusion

In this tutorial, we have accomplished the following:

Used the Report Power dialog box to verify and set device, thermal, and environmental
conditions that contribute to power estimation.

Synthesized the design and estimated the power after synthesis.
Set switching activities on an 1/O port and reran Report Power.

Ran functional simulation using the Vivado simulator and generated a SAIF file that is input to
Report Power for a more accurate power analysis.

Implemented the design, ran post-implementation timing simulation using the Vivado simulator,
and generated a SAIF file that is input to report power for a more accurate power analysis.

Ran Questa Advanced Simulator post-implementation timing simulation and generated a SAIF
file that is input to report power for a more accurate power analysis.

Performed power measurement on the design implemented in a KC705 and KCU105 Evaluation
Boards. Compared the hardware power numbers with the numbers generated by Vivado Report
Power.

Learned how to achieve power optimization as part of an implementation run.

Examined the power optimization report and selectively turned off power optimizations on a cell
in the design.

Examined the power saving of UltraScale BRAMs in cascaded mode when compared to BRAMs
in Non-cascaded mode.
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Please Read: Important Legal Notices

The information disclosed to you hereunder (the “Materials”) is provided solely for the selection and use of Xilinx products. To the maximum
extent permitted by applicable law: (1) Materials are made available "AS 1S" and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES
AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort,
including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to, arising under, or in
connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, incidental, or consequential loss
or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a result of any action brought by a third party)
even if such damage or loss was reasonably foreseeable or Xilinx had been advised of the possibility of the same. Xilinx assumes no
obligation to correct any errors contained in the Materials or to notify you of updates to the Materials or to product specifications. You may not
reproduce, modify, distribute, or publicly display the Materials without prior written consent. Certain products are subject to the terms and
conditions of Xilinx’s limited warranty, please refer to Xilinx’s Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos; IP
cores may be subject to warranty and support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or
intended to be fail-safe or for use in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products
in such critical applications, please refer to Xilinx’s Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos.

AUTOMOTIVE APPLICATIONS DISCLAIMER

AUTOMOTIVE PRODUCTS (IDENTIFIED AS “XA” IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF
AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE (“SAFETY APPLICATION”) UNLESS THERE IS A
SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY
DESIGN”). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS,
THOROUGHLY TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A
SAFETY DESIGN IS FULLY AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING
LIMITATIONS ON PRODUCT LIABILITY.

© Copyright 2012-2018 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Zyng, and other designated brands included herein
are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of their respective owners.
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